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1  |  Welcome
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Welcome
Welcome to Reckon Accounts. Whether you’ve been running your business for years or are just starting out, having 
an organised, efficient way to manage your business can save you time, money, and a lot of frustration.

Use this Startup Guide to get up and running as fast as possible. In this guide, you’ll learn about:

 How to install Reckon Accounts and set up your company file

 Important Reckon Accounts terms and concepts

 How to get around in Reckon Accounts

 Where to look for help when you have questions

 How to perform common tasks

Note: Since this guide covers multiple editions of Reckon Accounts, the name “Reckon Accounts” is used to refer to any of these 
editions. When information in this guide applies to a specific edition of Reckon Accounts, the specific edition name will be used.

How to use this guide
Page

7 Verify that your computer meets Reckon Accounts system requirements

Page

12 Install Reckon Accounts

Page

16 Update your company file (upgraders)
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Page

26 Convert data from other applications

Page

27 Create and set up your company file

Page

44 Learn how to get help if you have questions

Page

57 Learn about essential Reckon Accounts tasks
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Begin with the Reckon Accounts Installation and Upgrade Guide
In order to get the most from this Startup Guide, you should first install or upgrade your Reckon Accounts software 
so that you can follow along and explore the topics described.

For your convenience, the Reckon Accounts hardware and software requirements, and information about installing Reckon 
Accounts for new users and for multiple users is provided in this chapter.

However, if you are upgrading from an earlier version, you need to ensure that your company data file is properly upgraded 
for use with Reckon Accounts.  It is especially important that you carefully read and follow the instructions provided in the 
Reckon Accounts Installation and Upgrade Guide.

The Reckon Accounts Installation and Upgrade Guide provides important information that you need to know BEFORE 
you install or upgrade your software. You’ll save time, find answers to your questions, and avoid potential problems if you 
follow this step-by-step guide.

The Reckon Accounts Installation and Upgrade Guide is included with every purchase of Reckon Accounts. In 
addition, you’ll find the latest version of the Guide, including any last-minute changes or updates, on the Reckon 
Accounts web site:  
(https://www.reckon.com/au/downloads-guides/).
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System requirements
 2.0 GHZ Intel Pentium IV (or equivalent)

 1GB of RAM required for Windows 10 uses (Windows 10 require 1GB for 32Bit & 2GB for 64Bit.)

 1GB RAM for Windows Server 2012/2016/2019/2022*

 Windows 10/11 operating system

 1 GB of disk space (additional space required for company files) 

 Microsoft .NET Framework Common Language Runtime 2.0 & 3.5 (provided with the downloaded Reckon Accounts. 
By default, when you install Reckon Accounts, it extracts to C:\temp\Reckon_AccountsBusiness_20##_R#. Requires an 
additional 150 MB.)

 Requires 9 MB for Pro Timer 

 At least 256-colour SVGA video 

 1024 x 768 pixel screen resolution 

 DVD drive or internet connection for downloads

 All online features and services require Internet access with at least a 56 Kbps modem (ADSL or Cable Modem 
recommended) 

*Windows Server Essentials 2012 requires 4GB RAM.

Installing Reckon Accounts
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Integration/compatibility requirements
 Microsoft®Word, Excel and Outlook integration requires Microsoft Word, Excel and Outlook 2016, 2019, or 2021.

 Compatible with Reckon Point of Sale Professional 2019 (v22) or Reckon Point of Sale Lite 2019 (v22) 

*You may experience an issue when creating PDF files from Reckon Accounts if you are using Adobe Acrobat Reader 9.0. Please 
search PDF in our Knowledge Browser at https://help.reckon.com/ for more information.

Firewall and antivirus software compatibility 
If you use firewall or anti-virus software, it may be necessary to adjust settings in these applications to ensure 
the best possible performance with Reckon Accounts. Refer to your firewall or antivirus product documentation for 
further information.

Using firewall software on a network
If firewall software is running while you install Reckon Accounts, you may be asked if you want to allow Reckon 
Accounts components to have access to the network. For Reckon Accounts to operate properly (especially in a 
multi-user environment) these components (QBDBMgrN.exe, QBW32.exe, QBLaunch.exe, and QBUpdate.exe) must be 
allowed to access the network.

Different firewall software applications use different terminology when prompting you. Be sure to choose an option that 
does not block connections to Reckon Accounts components. Also, some firewall and antivirus software can affect Reckon 
Accounts performance. If you experience performance issues you think are related to your firewall software, refer to the 
firewall documentation or contact your firewall supplier for assistance.
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Multi-user installation requirements
Multi-user mode is optimised for Microsoft Windows Server 2012, Windows Server 2016, Windows Server 2019 and 
Windows Server 2022 operating systems, and for Windows 10/11**.

Terminal Services are supported for Reckon Accounts Premier and Enterprise.

**Not all versions of Windows 10/11 are supported. Support is provided for Windows 10 Pro and above. 
 

 

Installing Reckon Accounts
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About multi-user installation
Reckon Accounts lets you give multiple users access to Reckon Accounts company files on a network at the same time.

To enable other users to work in the company file, the company file must be stored on a computer on your network, and 
you need to complete some additional installation and setup steps on the computer where the company file is stored. 
Refer to “Installing and setting up Reckon Accounts for a multi-user environment” on page 18.

In a multi-user environment, Reckon Accounts (or the Reckon Accounts company File Server) should be installed on the 
computer on which the company file is stored. Each user must have a Reckon Accounts license and must:

 Install the same version. For example, all users must have Reckon Accounts.

 Have read/write access and create/delete rights to the directory where the company file is stored.

 Have a valid License Key and Product Key. 

Note: The company file can be accessed at the same time by up to 5 users with Reckon Accounts Premier, and up to 30 users with Reckon 
Accounts Enterprise.

Note: The number of users who can access the company file at the same time is not necessarily equal to the number of licenses you 
purchase. For example, using Reckon Accounts Premier, if you purchase licenses for 5 users, and then purchase an additional license for 
the sixth person in your office, only 5 of the 6 users can access the file at the same time. 

For setup on a simple network with no dedicated server
To run Reckon Accounts in a network environment with no dedicated server, Windows 8 or Windows 10 installed.

In a network environment with no dedicated server, each computer has its own copy of Reckon Accounts installed; 
however, the Reckon Accounts company file is located on only one computer, which must be turned on and available on 
the network. Networks set up for hosting files do not use a dedicated file server, so a single, dedicated computer is not 
required to share files. Thus, all the networked computers have the option to share their resources.
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For example, you might run your small business by using Reckon Accounts on two computers—yours and one that’s used 
by an employee. In this case, you still need to set up a simple network to share your company file. Otherwise, you’ll need to 
make a backup of your company file to move it or email it between the two computers.

For setup on a network with dedicated file server
To run Reckon Accounts in a network environment with a dedicated file server, you must have Windows Server 2012, 
Windows Server 2016, Windows Server 2019, Windows Server 2021, Windows 10, or Windows 11.

Networks with a dedicated file server have at least one computer (the file server) dedicated to sharing files, printers, or 
other resources. You should store your company file on the server.

Installing Reckon Accounts
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Installing Reckon Accounts
Reckon Accounts provides three different installation options. Refer to the table below to choose the installation option 
that’s right for you and then follow the appropriate instructions on the following pages.

Note: If you work in a multi-user environment, you might need to choose different installation options on each computer.

Choosing the correct Reckon Accounts installation option

Installation Option When to Use Refer to 

Install Reckon Accounts 
Only

 If you are a single user (the only person in your company running Reckon 
Accounts) and not accessing the company file from another computer on a 
network.

or

 If you run Reckon Accounts on a network and access the company file from 
another computer. (No other Reckon Accounts users will access a company 
file from this computer.)

Page 14 
(new users)

Page 15 
(upgraders)



13

Install Reckon Accounts 
with the Company File 
Server

 If you are working in a multi-user environment on a network, and this 
computer stores (hosts) the company file that other users will access from 
their computers.

or

 If you are running Reckon Accounts in a home office, where you run Reckon 
Accounts on two computers (perhaps a desktop and a laptop), but this 
computer stores (hosts) the company file that will be accessed by both 
computers.

Page 19

Install Reckon Accounts 
Company File Server 
Only

 If you are working in a multi-user environment on a network, and this 
computer stores the company file that other Reckon Accounts users will 
access, but no one will actually run Reckon Accounts on this computer. (This 
computer simply acts as a dedicated file server.)

Page 20

Note: Based on the installation type, each computer is configured to either “host” company files or not. If you need to change this setting 
after installation, refer to the in-product Help. Search for “hosting” to find related topics.

Installing Reckon Accounts
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Install Reckon Accounts Only, for new users
To install and start Reckon Accounts:

A Shut down all running programs, including anti-virus programs.

B Download Reckon Accounts installation files and open the downloaded file to start the installation. If you have the 
DVD, insert the Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, and then click Run. Type D:\setup.exe
(where “D” is the DVD drive letter). Click OK.

C In the Welcome to Reckon Accounts Installation window, click Begin.

D Read the Reckon Accounts licence agreement, click I accept the terms in the licence agreement, and then click Next.

E Enter your Installation Key Code (IKC), then click Next.

F Select Install Reckon Accounts Only, then click Install Now.

G Follow the onscreen instructions.

H To start Reckon Accounts, double-click the Reckon Accounts icon on the desktop or click the Windows Start button and 
then click Reckon Accounts from the Programs group.

Creating your company file
The first time you use Reckon Accounts, the Setup Interview window is displayed. The Setup Interview asks you questions 
about your business and then uses the information you provide to create your company file. For detailed information about 
creating your company file and setting up your company in Reckon Accounts, see “Setting Up Your Company in Reckon 
Accounts” on page 27.
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Install Reckon Accounts Only, for existing users 
(upgraders)
If you own a previous version of Reckon Accounts and are upgrading to 
Reckon Accounts, you must first install the new program and then update 
your company file.

Important: For your convenience, a simplified set of installation instructions 
for upgraders is provided here. However, you’ll save time, find answers to your 
questions, and avoid potential problems if you follow the instructions provided 
in the Reckon Accounts Installation and Upgrade Guide. To learn more about 
the Installation and Upgrade Guide, see page 6.

To install Reckon Accounts:

A Shut down all running programs, including antivirus programs.

B Download Reckon Accounts installation files and open the 
downloaded file to start the installation. If you have the DVD, insert the 
Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the 
taskbar and then click Run. Type D:\setup.exe (where “D” is the DVD drive 
letter). Click OK.

C In the Welcome to Reckon Accounts Installation window, click Begin.

D Read the Reckon Accounts license agreement, click I accept the terms 
in the license agreement, and then click Next.

E Enter your Installation Key Code (IKC), then click Next.

Back up your previous accounting system

If you have an existing business, make sure that 
you’ve backed up your financial records from 
your previous accounting system. In Australia, 
the ATO requires you to keep this information for 
seven years. You should also keep any software 
and hardware that your previous accounting 
system used, or have printouts of all the 
information and accounting reports.

Troubleshoot error messages

If you receive an error message during 
installation, and rebooting your system does 
not resolve the problem, you can search for the 
error message on the Reckon Accounts support 
site at  
www.reckon.com.

Did You Know?

Installing Reckon Accounts
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F Select Install ReckonAccounts Only, then click Install Now.

G Follow the onscreen instructions.

H After installation, the File Management Tool might instruct you to move your company files or to perform some 
additional installation modifications. Follow the onscreen instructions.

Note: We recommend that you keep your old version installed. You may need it to perform operations on your old company file.

I To start Reckon Accounts, double-click the Reckon Accounts icon on the desktop or click the Windows Start button and 
then click Reckon Accounts from the Programs group.

Updating your company file
This section describes how to update a company file created in a previous version. Before you can update your company 
data, you must install the new version of Reckon Accounts as described above.

Back up your data before opening it in a new version of Reckon Accounts. You can back up to your hard drive or to a 
backup disk.

Caution: After you update an existing company file to Reckon Accounts, do not delete your original company file. You may need 
it to generate reports on transactions before this date.

To update your file:

Note: If you are updating a company file from an earlier version, you will need to first upgrade your company file with 2007/08. If you 
need assistance, refer to the Reckon Accounts Installation and Upgrade Guide, or contact Reckon Technical Support.

A In Reckon Accounts, open your existing company data file.

B When prompted to update your file, enter YES and click OK.
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C Click Next and follow the onscreen instructions.

 When prompted to back up your company file, choose the directory on your hard drive or the disk drive where 
you want to store your backup file and click OK.

Failing to back up your file might result in lost data if you encounter a problem during the update process. Do not 
overwrite existing backups with this upgrade backup.

 If prompted to move or rename your company file, we recommend that you allow the utility to move your company 
file from the Program Files folder to C:\Users\Public\Public Documents\Intuit\QuickBooks\
Company Files.

Note: The Windows Program Files folder is no longer a recommended location for storing company files.

D When Reckon Accounts indicates that it is ready to upgrade your company file, click Finish. Depending on the size of 
your company file, the upgrade process may take up to an hour.

Note: Due to changes and improvements in the Reckon Accounts data file format, the size of your company file might significantly 
increase after you update it.

If an update problem occurs
If you attempted to upgrade your file and the update failed, you must perform steps in your earlier version to fix the 
problem. If you removed your earlier version, reinstall it to a new directory. Do not install the older version in the directory 
where you installed Reckon Accounts.

To fix a failed file update:

A Start the earlier version.

B Open the earlier version of your company file. If necessary, you can restore your company backup using the earlier 
version. Go to the File menu, click Open or Restore Company, and then follow the onscreen instructions.

Installing Reckon Accounts
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C Go to the Window menu and click Close All.

D Go to the File menu, click Utilities, and then click Rebuild Data.

Caution: The Rebuild Data utility forces you to create another backup. Use a new DVD or USB drive. Do not overwrite any 
existing backups.

E After the rebuild is complete (which may take a long time depending on the size of your company file), exit the earlier 
version.

F Start Reckon Accounts.

G Go to the File menu and click Open or Restore Company.

H Select the appropriate directory and file name of the company data you just rebuilt and click OK. The update should 
take place normally. If you still experience update problems, refer to the Reckon Accounts Installation and Upgrade 
Guide, or contact Reckon Technical Support.

Installing and setting up Reckon Accounts for a multi-user environment
There are two ways to set up Reckon Accounts to be used in a multi-user environment, which will allow more than one user 
to access your Reckon Accounts company file at the same time.

 The Simple Network installation enables users on a network to share files between their computers directly (there is 
not dedicated file server).

 The Server installation enables you to place your Reckon Accounts company file on a dedicated file server where all 
users can access the file. 

For all installations, you must then follow the “Completing Multi-user setup” instructions on page 21.
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Simple Network Installation:  For multi-user environments in which users will access the company file(s) on this computer 
from another computer on the network. The user on this computer will also run Reckon Accounts. (In this type of network, 
computers are connected to each other, but there is no machine configured as a dedicated file server; instead, each 
computer on the network can be configured to share files.)

A Make sure your computers are properly networked. Refer to your operating system’s documentation for more 
information.

B Shut down all running programs, including antivirus programs.

C Download Reckon Accounts installation files and open the downloaded file to start the installation. If you have the DVD, 
insert the Reckon Accounts DVD in your computer’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, then click Run. Type D:\setup.exe (where 
“D” is the DVD drive letter). Click OK.

D In the Welcome to Reckon Accounts Installation window, click Begin.

E Read the Reckon Accounts licence agreement, click I accept the terms in the licence agreement, and then click Next.

F Enter your Installation Key Code (IKC), then click Next.

G Select Install Reckon Accounts with the Company File Server, then click Install Now.

H Follow the onscreen instructions.

I After installation, you may be asked to move your company files to another directory, or to perform some additional 
installation modifications. You can also scan your computer for company files that need to be shared. Follow the 
onscreen instructions.

New users should proceed to setting up the company file as described in “Setting up Your Company in Reckon 
Accounts” on page 27. Upgraders should update their existing company file by following the detailed instructions in the 
Installation and Upgrade Guide.
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For each additional user who will use Reckon Accounts on the network, follow steps 1 through 8 above, except in step 
7, choose Install Reckon Accounts Only instead.

Dedicated File Server Installation: For multi-user environments using a dedicated file server to store the Reckon 
Accounts company file(s). This computer stores the company file, but no one runs Reckon Accounts on this 
computer.

A Make sure your computers are properly networked. Refer to your operating system's documentation for more 
information.

B Shut down all running programs, including antivirus programs.

C Download Reckon Accounts installation files and open the downloaded file to start the installation. If you have the 
DVD, insert the Reckon Accounts DVD in your server’s DVD drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar, then click Run. Type D:\setup.exe (where 
“D” is the DVD drive letter). Click OK.

D In the Welcome to Reckon Accounts Installation window, click Begin.

E Read the Reckon Accounts license agreement, click I accept the terms in the license agreement, and then click Next.

F Enter your Installation Key Code (IKC), then click Next.

G Select Install Reckon Accounts Company File Server Only, then click Install Now.

H Follow the onscreen instructions.
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I At the end of the server installation, you must launch the Reckon 
Accounts Database Server Manager from the System Tray or from All 
Programs and scan the server for company files.

J For each additional user who will use Reckon Accounts on the network, 
follow the instructions above except in Step 7, choose Install Reckon 
Accounts Only instead.

Hosting Multi-user access
The installation option you choose configures the hosting settings for each 
computer. If you need to change the hosting settings after installation, 
refer to the multi-user setup topics in the in-product Help.

Note: If you cannot install Reckon Accounts or the Reckon Accounts Server on the 
computer where your company file is located, you will need to choose a computer 
to act as the “host.” On that computer, open each company file in multi-user mode 
to configure the alternate hosting settings. For detailed steps, see the in-product 
Help topics for using the “Alternate Setup” for multi-user mode.

Completing Multi-user setup
After you install Reckon Accounts on each computer on your network and 
set up your company file, you need to perform these additional tasks:

 Set up user names and passwords for each user. You will need to assign 
one user to be the Administrator who defines all other users’ access. 
Refer to the in-product Help for instructions on setting up user names 
and passwords.

Installing from a server

If your Reckon Accounts DVD is mounted on a 
server or a shared DVD drive, you can install 
from the DVD, but you cannot install from the 
DVD to a remote computer.

Choosing where to store your company file in a 
multi-user environment

Choose a location for your company file where 
all the computers that need to use Reckon 
Accounts can access the file. For a simple 
network system with no dedicated file server, 
you might want to put the company file on the 
computer of the person who most frequently 
uses Reckon Accounts. This enables that 
person to have the fastest access to the 
company file.

Improving performance in multi-user mode

To improve Reckon Accounts performance in 
multi-user mode, consider these tips:

 Store company files on the fastest or most 
powerful computer, preferably a dedicated file 
server.

 Run large reports outside of business hours.

 Refresh reports only when you’re ready to use 
or print them.

 Avoid keeping unnecessary Reckon Accounts 
windows or other applications open.

Installing Reckon Accounts
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 Share the folder that contains your Reckon Accounts company file across your network. You can press F2 while in 
Reckon Accounts to locate your company file. See your operating system’s documentation to learn more about 
sharing folders.

 Activate each copy of Reckon Accounts, as described in “Activating Reckon Accounts” on page 25.

 Turn on multi-user mode in each copy of Reckon Accounts you have installed on your network.

A Go to the File menu and click Switch to Multi-user Mode.

B Click Yes.

Note: Based on the installation type, each computer is configured to either “host” company files or not. If you need to change this setting 
after installation, refer to the in-product Help. Search for “hosting” to find related topics.

You may need to expand the number of people who work on Reckon Accounts in the future. Each additional user must 
have his or her own license. 

Why are passwords important? 
Passwords limit access to your company file. To open a password-protected file, each person must enter his or her user 
name and a unique, case-sensitive password. Defining users and passwords helps prevent unauthorised people from 
accessing your company’s confidential data.

We strongly recommend that you password-protect the Admin user. Otherwise, anyone who can access the company file 
will have full access rights. By defining users and their access rights, you not only control who can open your company file, 
but also what data they can view and tasks they can perform.
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Troubleshooting installation problems

What should I do if I have trouble installing Reckon Accounts?
A Verify that your system meets the minimum system requirements, listed on page 7.

B Restart your computer.

C Close all open programs, including anti-virus programs. Go to the Windows Task Manager (Task List), click the 
Applications tab, and close all open programs.

D Try installing Reckon Accounts again.

If you need further installation assistance, contact Reckon Technical Support. You can also visit the Reckon Accounts 
support website at https://www.reckon.com/au/support.

What should I do if I can’t find my Registration Number? 
Reckon Accounts no longer uses registration numbers. The only number you’ll need is your Installation Key Code (IKC), 
found by logging into the Members Site with your Customer ID and Pin number > Download Software or by clicking My 
License Information from the Help menu.

Why doesn't my old administrator password work after I upgrade? 
From 2004 release and later, case-sensitive passwords are supported. If you believe you are entering the correct password, 
but are still getting the message “The password you typed is incorrect.” try the following:

 Attempt to log on by entering the login name of Admin and then click OK without typing a password.

 Enter your password with Caps Lock or Num Lock turned on or off.

 Enter password variations, using mixed upper- and lower-case characters.

Installing Reckon Accounts
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 Enter the password with a space before or after the actual password.

 Type the password in a text editor to confirm that your keyboard is functioning properly.

 Restore a pre-update backup of your file that does not have the case-sensitive password. When you restore this file, you 
can set your new administrator password at the end of the update process.

If you are still unable to access your file, contact Reckon Technical Support for assistance. 

Can I install different versions of Reckon Accounts on the same computer?
Yes. You can install multiple versions of Reckon Accounts on the same computer. 

Can I revert to an earlier version?
Yes. Uninstall the version of Reckon Accounts that you don’t want and then reinstall the earlier version. Remember that you 
will not be able to open company files that you have updated to Reckon Accounts in earlier versions. You can, however, 
restore your pre-update backup if you choose to go back to a prior version.

Can I install Reckon Accounts on more than one computer?
No. The Reckon Accounts license agreement allows Reckon Accounts to be installed on only one computer.  If you wish to 
install Reckon Accounts on a second computer, you must purchase an additional licensed copy.

Note: Reckon Accounts Premier and Enterprise come with multiple licences, so they can be installed on multiple computers.
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What should I do if I get an error message during installation?
If you receive an error message during installation and rebooting your 
system does not resolve the problem, go to the Reckon Accounts website 
(https://www.reckon.com/au/support) and search the Knowledge Base for 
solutions to common errors, or contact Reckon Technical Support.

What should I do if I get an error message when updating my 
company file?
If you receive an error message when updating your company file from a 
earlier version, refer to the information in “If an update problem occurs” on 
page 17. You can also visit the Reckon website (https://www.reckon.com/
au/support) and search the Knowledge Base for information about error 
messages, or contact Reckon Technical Support.

Record your password in a safe place

Be sure to write down and save your 
administrator password in a secure place. 
Passwords not only protect your company data, 
but are also required to access your company 
file if you upgrade your version. 

Passwords are case sensitive

Keep in mind that passwords are case sensitive. 
When adding or editing a user password, check 
the Caps Lock and Num Lock keys. If you 
mistype the password, you will not be able to 
access the company data.

Product Information window

The Product Information window lists information 
about your software, including the number of 
entries you have in your lists, the size of your 
company file, which version of Reckon Accounts 
you are running, and the location of your 
company file. To open the Product Information 
window, press F2 on your keyboard.

Installing Reckon Accounts

Did You Know?
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Activating Reckon Accounts
You can use Reckon Accounts up to 6 times without activating. After 6 sessions, you must activate Reckon Accounts.

Go to the File menu and click Activate Reckon Accounts. You can also activate by online chat by visiting:
https://www.reckon.com/au/support/activation/.

Note: If you choose to install Reckon Accounts on a second computer, or if you need to move your installation to another computer, 
you will need to re-activate Reckon Accounts.

Getting the latest updates to Reckon Accounts
From time to time, Reckon provides updates to Reckon Accounts that can be downloaded from the Internet. These 
updates might include new features, services, maintenance fixes, or new Help information.

Updates are available at the Reckon Accounts website (www.reckon.com). Click Learn & Support menu, then click  
Support Hub and then navigate to the Software Downloads section.

Converting data from other applications
If you are converting financial data from another application (such as Microsoft Excel), follow the instructions below.

Excel
Detailed instructions about importing Excel® (.xls) and comma separated values (.csv) data into your Reckon 
Accounts company file are provided in the Reckon Accounts in-product Help. Importing data from Excel and .csv files 
is not difficult, but does require you to prepare the file properly.
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To view the file preparation and conversion instructions:

A Start Reckon Accounts. Go to the Help menu and click Help.

B Click the Search tab in the Help window.

C Click in the Search field and enter importing Excel data.

D Click About importing data from an Excel or CSV file.

Note: If your Excel file is ready to be converted, you can convert it. Go to the File menu, click Utilities, click Import, and then click 
Excel Files.

Setting Up Your Company in Reckon Accounts
The first thing you need to do in Reckon Accounts is create a company file for your business. Setting up your 
company file properly is the most important thing you can do to have Reckon Accounts help you manage your 
business efficiently.

The setup process is easy with the Setup Interview and should take you about 15 minutes to complete. Then, 
depending on the complexity of your business, completing your company setup can take anywhere from a few 
minutes to a few hours. The amount of time varies based on how much detail you add about your accounts, 
customers, suppliers, employees, products, and services, as well as the number of historical transactions you want 
to enter.

When you set up your company file, Reckon Accounts will prompt you for details about your company. Before you 
begin the setup process, gather the information shown in the Getting Started Checklist. Some of this information 
you’ll need for the Setup Interview; other information you will need as you begin to use Reckon Accounts.

Installing Reckon Accounts
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Creating your company file
After you have gathered the company information listed in the Getting Started Checklist, you can set up your business 
using the Reckon Accounts Setup Interview. (Not all of the information in the checklist is required for the Setup Interview; 
however, you will need this information as you use Reckon Accounts to run your business.) The Setup Interview walks you 
through the setup procedure and helps you tailor Reckon Accounts for your business.

Getting Started Checklist

Company name 
and address

You’ll need both the trading and legal names for your company. The legal company name is the 
name you use when filing taxes for your business. The trading company name is the name that you 
want to appear on invoices, statements, reports, etc. (This is your “Doing Business As” name.)

Start date

Reckon Accounts uses a start date as the point at which you begin entering your business 
transactions. You must enter all historical transactions between your start date and today to ensure 
complete accounting records for your business. 

Many business owners base their accounting records on their financial year, so that they can see 
transactions for the entire year. If this is not important to you, you can choose a different starting 
point, such as today or the first of the month, quarter, or year.

Australian Business 
Number (ABN)

The Australian Business Number (ABN) is a single identifier for all business dealings with the tax 
office and for dealings with other government departments and agencies.  In Reckon Accounts, your 
ABN will serve as your Tax ID.
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Getting Started Checklist

Bank statements, 
credit card 
accounts, and 
outstanding 
cheques

You’ll need the most recent bank statement for one of your bank accounts with a closing date that’s 
before your start date. The closing balance on this statement will be your opening balance for the 
bank account you create in Reckon Accounts, and then you’ll enter all the open transactions, and 
all the new transactions from the start date forward. Eventually, you will need to have your latest 
bank statement balances and any outstanding cheques, deposits, withdrawals, or charges for all 
of the accounts you want to set up and manage in Reckon Accounts, including credit cards, bank 
accounts, lines of credit, and loans.

Assets and Liabilities
You will need the balance of each loan your business owes (liabilities) such as a bank loan, hire 
purchase, or director’s loan; or is owed (assets). If you have stock, you need to know its value as of 
your start date.

PAYG Liability
If you are operating payroll, you need to know how much PAYG tax you owe to the ATO as of your 
start date.

Payroll
If you are using Payroll, you should gather the following information from your employees: company 
information; compensation, benefits, and miscellaneous additions and deductions; tax information; 
employee information; year-to-date history; and liability payment information.

Optional 
information

Eventually, you will need to enter detailed information about your customers, suppliers, and 
employees, as well as the products and services you sell, the products that you hold in stock, and 
any additional assets.

To create your company file:

A Start Reckon Accounts by double-clicking the Reckon Accounts icon on the desktop or by clicking the Windows Start 
button and then clicking Reckon Accounts from the Programs group.

B Click Create a new company file, or go to the File menu and click New Company.

Installing Reckon Accounts
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C The Welcome screen for the Setup Interview opens. Click Start Interview.

Note: We recommend that you do not skip the interview process. The more information you enter with the Setup Interview, the 
more accurate your company file will be when you begin to use Reckon Accounts for your business.

However, if you are an experienced Reckon Accounts user and prefer to create your company file manually, you can skip the 
Setup Interview by clicking Skip Interview on the Setup Interview Welcome screen. You will be prompted to enter some basic 
company information and to save the company file.

D Follow the onscreen instructions and complete the interview. Make sure you write down where you are saving 
your file for future reference.

Completing your company setup
After you’ve created your company file, you can begin using Reckon Accounts to run your business. But before you 
do, we recommend that you review the information in this section to make sure your company file is properly set up 
and that your data is complete.

This section describes some additional tasks you might need to do as you begin using Reckon Accounts. Depending 
on how much information you entered during the Setup Interview, some of these tasks might not apply to you.

Enter your company information
Do this task if you did not enter this information in the Setup Interview.

To enter the contact and legal information for your company, go to the Company menu and click Company 
Information. To learn more about each of the fields and where the information you enter will be used in Reckon 
Accounts, click the Help button.
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Review your Chart of Accounts
If you used the Setup Interview, a chart of accounts based on your type 
of business was set up for you. Review the chart of accounts to be sure it 
accurately reflects the accounts you need to run your business. You can 
change account names and edit, delete, or add accounts as necessary. 
For example, you will need to add any personal bank, credit card, or loan 
accounts.

To view your Chart of Accounts, go to the Lists menu and click Chart of 
Accounts.

Numbering your accounts
Some businesses prefer to organise their accounts by number. Adding 
numbers can help you identify the type of accounts, thereby speeding 
up your account selection on various forms. You might want to develop 
and follow a consistent account naming and numbering convention. For 
example:

1000-1999 - Assets

2000-2999 - Liabilities

3000-3999 - Equity

4000-4999 - Income

5000-5999 - Cost of Goods Sold

6000-6999 - Expenses

7000-7999 - Other Income

Company file

The company file is the data file that Reckon 
Accounts uses to store and manage all the 
information and financial transactions for your 
business. Reckon Accounts company files have 
the extension .qbw.

Historical transactions

A list of all business transactions as of a 
specific date. In Reckon Accounts, you can have 
many different lists of historical transactions, 
including:

 Estimates  Invoices

 Sales receipts  Customer payments

 Adjustment notes  Purchase orders

 Item receipts  Bills

 Payments to suppliers  Credits with suppliers

 Journal entries  Payroll transactions

Emailing a company file

The Reckon Accounts portable company file 
(*.qbm) is a compact version of your company 
file. You can use the portable company file to 
move the company file to another computer or 
to email the company file to another person, 
such as your accountant. To learn more about 
the portable company file, refer to the in-product 
Help.

Installing Reckon Accounts
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8000-8999 - Other Expense

If you want to use numbers to identify your accounts, you need to turn on this preference in Reckon Accounts, as follows. 

A Go to the Edit menu and click Preferences. 

B In the Preferences window, click Accounting in the list on the left.

C Click Company Preferences. 

D Select the Use account numbers checkbox. 

E Click OK.

Create your customer, supplier, and items lists
To bill customers and pay your bills with Reckon Accounts, you must update your customer, supplier, and item lists 
so that they accurately reflect your business. Instructions for setting up these lists are provided in Chapter 4:

 “Adding Customers” on page 69

 “Adding Suppliers” on page 72

 “Adding Items” on page 75

Enter historical transactions
If your start date is before today’s date, you’ll need to enter past transactions from the start date to today. This 
ensures that your Reckon Accounts records are completely up-to-date and your reports will be accurate.

Enter historical transactions in chronological order. For example, Reckon Accounts won’t know how to credit a 
customer payment unless you’ve previously recorded the invoice to that customer. The most efficient way to enter 
historical transactions is in the account register.
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Note: Entering historical transactions is especially important if customers don’t pay you at the time they receive goods or services. If you 
don’t enter historical transactions early on, it’s hard to track and collect late customer payments.

Reckon recommends that you enter your transactions in this order (verify with accountant):

 Invoices or statements you’ve sent out since your start date

 Purchase orders you’ve issued since your start date that you haven’t received in full

 Cash or cheques you’ve received since your start date

 Bills you’ve received since your start date

 Bills you’ve paid since your start date

 Deposits you’ve made to any of your accounts since your start date

 Any other cheques you’ve written (for things other than bills) since your start date

 Employee year-to-date information accrued from the beginning of the financial year through your start date

 Payroll liabilities owed at the time of your start date (for manual payroll and tracking payroll transactions only)

Note: If you don’t have time to enter all your historical transactions right away, don’t worry. You don’t need to enter all your past 
transactions before you start using Reckon Accounts for new transactions. Enter new transactions as they occur. Then catch up with 
historical transactions when you can. Remember, though, that your account balances will be incorrect (and your reports may be wrong) 
until you enter all the past transactions.

Complete your bank account information
After you’ve entered your historical transactions, your account registers will contain entries reflecting bills you’ve paid, 
cheques and payroll payments you’ve written, and deposits you’ve received. To make your account registers complete, you 
must also enter these transactions:

Installing Reckon Accounts
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 Cheques or other charges that happened before your start date but didn’t appear on statements before your start date 
(i.e., didn’t clear)

 Other cheques you wrote after your start date that were not for bills or accounts payable (for example, credit card 
payments)

 Deposits you made after your start date that were not customer deposits

 Deposits you made before your start date but that didn’t appear on statements before your start date

 Bank charges and fees

 Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter these transactions to make your account 
registers accurate.

Enter any optional adjustments
After you’ve created your company file, you might need to make a few adjustments as of your start date. Depending on 
your company, you might need to:

 Enter any tax liabilities

 Adjust the Uncategorised Income and Uncategorised Expense accounts (for accrual basis only)

 Adjust for current income and expenses if your start date is not at the beginning of the financial year

 Distribute earnings and equity before your start date

Refer to the in-product Help for step-by-step instructions on how to enter these optional adjustments. If you are unsure 
whether you need to enter these optional adjustments, check with your accountant.
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Backing up your company file
The Reckon Accounts backup file is a compressed version of your 
Reckon Accounts company file that contains all transactions through 
the date the company backup was made. A backup file provides 
insurance against accidental data loss and can be used to restore your 
data. Reckon Accounts backups have a .qbb extension and cannot be 
opened directly.

Reckon Accounts provides the following backup options for securing 
your data:

 Standard backup

 Portable Company File

To use one of the backup options, go to the File menu and click Save 
Copy or Backup.

To restore your backup, go to the File menu and click Open or Restore 
Company.

To learn more about backing up your company file, refer to the in-
product Help.

Next steps
After you’ve installed Reckon Accounts and set up your company file as 
described in this chapter, you should:

 Learn how to use Reckon Accounts and get answers to your 

Assets

Company assets are the things that your 
company owns. Reckon Accounts distinguishes 
between two types of assets:

Current assets: Assets that you are likely to 
convert to cash within one year (such as the 
cash you have on hand, the money in your 
current and savings accounts, and the money 
your customers owe you).

Fixed assets: Assets that you do not expect to 
convert to cash within one year. A fixed asset is 
usually something you use to run your business 
(such as a truck, cash register, or computer).

Confirming your opening balance when 
transferring data to Reckon Accounts

If you used an accounting program before using 
Reckon Accounts and you are now transferring 
data from that program to Reckon Accounts, 
make sure that the opening balance for your new 
bank account in Reckon Accounts is based on 
your bank statement and not the bank balance 
from your previous accounting software. The 
balance of the bank account from your previous 
accounting software will not include post-dated 
transactions or transactions that the bank has 
cleared.

Installing Reckon Accounts
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questions (see Chapter 3).

 Learn how to perform basic Reckon Accounts tasks (see Chapter 4).



Accounts
3  |  Learning Reckon 
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Getting Around Reckon Accounts
The Reckon Accounts work area is designed to enable you to complete tasks quickly. Reckon Accounts provides 
several ways for you to work; choose the method that works best for you.
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Using the Home page to move around in 
Reckon Accounts
When you open a company file in Reckon Accounts, the Home page 
is displayed automatically. The Reckon Accounts Home page provides 
a big picture of how all your essential business tasks fit together. 
Tasks are organised into logical categories (Customers, Suppliers, 
Employees, Company, and Banking) with workflow arrows to help you 
learn how tasks relate to each other and to help you decide what to do 
next.

Note: The workflow arrows indicate a logical progression of business tasks in 
Reckon Accounts. However, these arrows do not restrict you from doing tasks in a 
different order, or an order that works better for your business needs.

To start a task, simply click the icon for the task you want to do. For 
example, to create an invoice, click the Invoices icon.

To return to the Home page, click the Home button on the navigation 
bar.

The Home page also provides a quick glance about the state of 
your business. You can see your current account balances, updated 
automatically as you do work in Reckon Accounts, in the Account 
Balances list.

The Home page you see has been customised to display only those 
tasks and features that you use, based on the questions you answer 
in the Setup Interview. Functions you don’t need won’t clutter your 
workspace. However, if you decide to use these functions later, you 

Customising the desktop
You can modify the way that the Reckon 
Accounts desktop behaves and looks to suit 
your working style. To modify the Reckon 
Accounts desktop, go to the Edit menu and click 
Preferences.

Customising the icon bar
You can add, rearrange, and remove shortcuts 
from the icon bar to suit your needs. To modify 
the icon bar, go to the View menu and then click 
the Customise Icon Bar.

Too many windows open?
If your Reckon Accounts work area becomes too 
cluttered with windows that you have open, you 
can close them all at once instead of closing 
them one at a time. To close all open windows, 
go to the Window menu and click Close All.

When you close your company file at the end of 
the day, it’s good practice to close all windows 
that you have open. The next time you open your 
company file, Reckon Accounts will open all the 
windows that you had open when you closed 
your company file. If you forget to close open 
windows when you exit Reckon Accounts, hold 
down the Alt key while opening your company 
file. Reckon Accounts will open your company file 
with no windows open in your work area.

Learning Reckon Accounts

Did You Know?
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can always add them back to the Home page by clicking the Customise Reckon Accounts link in the Getting Started 
section of the Home page.

Finding your data in the Reckon Accounts Centres
Reckon Accounts includes Customer, Supplier, and Employee Centres where you can view and manage all of your 
customer, supplier, and employee information and transactions. You can go to one of the Reckon Accounts Centres 
by clicking the appropriate button in the navigation bar (on the left side of the toolbar).

Customer Centre
The Customer Centre lets you view and work with all your customer information. Without having to sift through 
multiple screens, you can view a list of all your customers and see pertinent information for each of them. Click on 
a customer’s name and you’ll immediately see all the activity you’ve had with them as well as their pertinent contact 
information (phone number, fax number, and payment terms).

You can use the Customer Centre to find out how much money a specific customer owes you, or to view a list of all 
your customers with open balances. You can also look at all your customer transactions (estimates, sales orders, 
invoices, adjustment notes, refunds, etc.) across all of your customers in the Transactions list rather than having to 
run separate reports.
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Easily add customers and 
jobs. Create new transactions 
(estimates, invoices, sales 
orders).

 
Use the Transactions tab to 
find, sort, and filter all your 
transactions across all of your 
customers.

 
Click a customer in the 
Customer & Jobs list to view 
useful data.

 
View all of your past 
transactions with this 
customer, or filter this list 
to display only one type of 
transaction, like overdue 
invoices.

 
Easily access your customer’s 
contact information and any 
notes on that customer.

 
Run quick reports that pertain 
to this customer.
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Supplier Centre
The Supplier Centre gives you a complete picture of where your money is going. From one screen, you can see all 
your suppliers and exactly what you owe them. Simply click a supplier’s name to view your entire history with that 
supplier. You no longer need to run separate reports to see exactly how much business you’re doing with each 
individual supplier. And, you can sort your bills by due date so you can stay on top of your finances. 

If you need to talk to a supplier, click their name and you’ll see all their contact information. If a supplier calls you to 
follow up on a late payment, you can quickly look up the bill and see when you paid it and what the cheque number 
was. 

Employee Centre
From the Employee Centre, you can see exactly what you’re paying each employee. Simply click an employee’s name 
to view that person’s payroll history. And if you need to get in touch with an employee, their contact information is 
right in front of you.

Payroll Centre
The Payroll Centre is the hub for managing all payroll activities. The Payroll Centre reminds you of important payroll 
dates so you pay your employees, pay your payroll liabilities, and file forms on time.

To view the Payroll Centre, go to the Employees menu and click Payroll Centre.

Displaying multiple windows or one window
Reckon Accounts is preset to show multiple windows at a time. By doing so, you can easily navigate between tasks 
as well as compare data in multiple windows. When you open a window, it opens to a preset size and location. You 
can resize and move each window as you see fit.
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Depending on how you size or arrange the windows, some windows might not be visible. Use the Window menu to 
view a list of the open windows. Simply click the window name in the list to bring it to the front.

Alternatively, you can open the Open Window List to have the list of open windows always visible on the left side of the 
Reckon Accounts application window. If you prefer to view only one window at a time, go to the View menu and click One 
Window.

Adding icons to the icon bar
For quick access to the areas of Reckon Accounts you use most, you can customise the icon bar by adding many of 
the features and reports that you use most frequently.

View Lists

Open Window List

Icon Bar
Customise Icon Bar...
Add “Chart of Accounts”to Icon Bar...

Accountant Company

Navigation Bar

Custom

 

To add a shortcut to Accounts
window, open the window and then
go to the View menu and click
the Add to Icon Bar option.

You can add, rearrange, or remove
shortcuts from the icon bar in the
Customise Icon Bar window.

Note: Some Reckon Accounts windows cannot be added to the icon bar.

Learning Reckon Accounts
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Getting Answers to Your Questions
Reckon Accounts provides a variety of tools and resources to help you find answers to questions you might have 
when using Reckon Accounts. Available resources include:

 In-product Help

 Additional self-help tools

 Assisted support

 Reckon Professional Partners

Using in-product Help
Reckon Accounts in-product Help provides background information and instructions for doing Reckon Accounts 
tasks. You can access the Help content and features in several ways.

To use in-product Help, go to the Help menu and click Reckon Accounts Help.
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Getting step-by-step instructions
Throughout Reckon Accounts you’ll find windows with a How Do I button. Clicking this button provides quick access 
to instructions for tasks associated with the window.

Learning Reckon Accounts
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Viewing Help for a window you have open
If you are unsure how to use a particular Reckon Accounts window, press the F1 key on your keyboard to get help. 
(You can also click the Help button to view these Help topics.) These Help topics provide answers to questions such 
as:

 What can I use this form for?

 What does this button do?

 What kind of information is displayed in this column?

 What happens when I select this option?
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Using Help Search and Index to find information 
Reckon Accounts in-product Help is quite extensive. Use the Help Search and Index to find answers to your questions 
quickly.

To find information using Search:

 Type your question in the Ask field in the title bar of most Reckon Accounts windows and click Ask; or

 Go to the Help menu, click Reckon Accounts Help, and then click the Search tab. Enter your question in the 
Search field and click Ask.

Tip: Using Search Effectively  Entering questions of 3-10 words produces better search results than simple 
keywords. For example, instead of typing “invoices,” enter How do I create invoices? in the Ask field.

Make your questions as specific as possible. They should not get too long or contain too many keywords. For 
example, “How do I add customers?” will return better results than “How do I add new customers and suppliers?”

If you get no search results, check the spelling in your question. Reckon Accounts knows about some common 
misspellings, but other misspellings will not be caught. Do not use abbreviations. Try different keywords.

If you can’t find your answer in the topics returned by search, click the Show all results checkbox to see more 
topics.

To find information using the Index:

A Go to the Help menu, click Reckon Accounts Help, and then click the Index tab.

B Enter a term in the blank field. The index will scroll and display the available entries.

C Double-click the index entry that best describes that information you want.

Learning Reckon Accounts
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Using the sample company files
Reckon Accounts includes several sample company files that you can practice with to enter pretend data, run 
reports, and explore Reckon Accounts features.

To open a sample company file, go to the File menu, click Open or Restore Company, and then click a sample 
company file from the list.

Additional Self-Help Tools
If you cannot find the answer you want in the in-product Help, try these other resources.

Support Resources page in Reckon Accounts
From the Support Resources page, you can:

 Learn about your assisted support options and how to contact Reckon

 Learn about and sign up for support plans

 Find a Reckon Accounts Reckon Accredited Partner

 Learn about training resources

To open the Support Resources page, go to the Help menu and click Contact Support.

Online Knowledge Browser
The online Reckon Accounts Knowledge Browser (https://help.reckon.com) provides a free library of articles for each  
Reckon Accounts product family. In the Knowledge Browser, you can find:

 Answers to common user questions

 Product update information
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 Useful links to product updates, support plans, customer service, 
and current news articles

 Technical help for a variety of Reckon Accounts issues

Getting Assisted Support
If you cannot find the answer you want using the in-product Help or 
other self-help tools, get assistance from a Reckon Accounts expert.

To learn more about free and paid Reckon Accounts Assisted Support 
options and how to get help, go to the Help menu and click Contact 
Support, or open a web browser and visit www.reckon.com.

Working with a Reckon Accredited Partner
From time to time, you might need advice that is very specific to your 
business situation. In this case, you’ll want to contact your accountant 
or another specialised professional.

If you do not have an accountant or bookkeeper working for you, 
you can find a Reckon Accredited Partner located near you from our 
website. Reckon Accredited Partners are independent accountants, 
bookkeepers, computer consultants, and trainers who work with small 
businesses every day. They can offer guidance on everything from 
business planning to tax advice.

To find a Reckon Accredited Partner in your area, open a web browser 
and visit  
https://partnersearch.reckon.com.

Getting help from Reckon Accounts 
professionals
Want local professional help setting up or 
customising your Reckon Accounts? You’ll 
get the most out of Reckon Accounts when a 
Reckon Accredited Partner helps you customise 
the software for your unique needs.

 Save time and money by getting your Reckon 
Accounts setup right the first time, rather than 
fixing mistakes down the road.

 Reckon Accredited Partners can help you 
set up appropriate reports so you can easily 
understand the health of your business

If you don’t currently work with an accounting 
professional, or your accountant isn’t a Reckon 
Accounts expert, you can look for a Reckon 
Accredited Partner in your area who can help you 
set up and customise your Reckon Accounts by 
visiting www.reckon.com and clicking Find an advisor.

Did You Know?
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Reckon Accounts Basics
To take full advantage of Reckon Accounts, there are some important concepts you need to understand.

How Reckon Accounts lists work
Lists are one of the important building blocks that make Reckon Accounts so powerful and efficient. You use 
information stored in lists to fill out most Reckon Accounts forms. For example, to create an invoice, you choose the 
customer name from your Customers & Jobs list. Reckon Accounts automatically enters the customer information on 
the form for you. This saves you time and prevents typing errors. You can also change the information directly on the 
form as needed. Lists are easy to set up in Reckon Accounts, but do require careful planning.

Depending on the type of list you want to use, you can get to the list in one of two ways:

 Reckon Accounts Centres: Your Customers & Jobs, Suppliers, and Employees lists are available in the 
Customer, Supplier, and Employee Centres, respectively. Click the appropriate Reckon Accounts Centre button on 
the navigation bar to go to a Reckon Accounts Centre. Then, click the tab for your list.

 List windows: Other lists, such as the Chart of Accounts and Item list, appear in separate windows. To view one of 
these lists, click the Lists menu and then click the list you want. To enter information in these lists, use the menu 
button at the bottom of the list to add, edit, or delete list items. The list menu also provides access to common 
features associated with the list.

The more detail you enter for each list item, the more information Reckon Accounts can use to pre-populate forms, 
track financial data, and display useful reports about your business. Another advantage of lists is that common 
tasks like adding list entries, editing list information, and deleting list entries are performed the same way.

The figure below illustrates how Reckon Accounts uses list information across multiple windows and tasks to simplify 
data entry and to give you a complete picture of how your business is doing.
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6. To view a list of in
    use the Transactions 

1.
    Click Ne
    to your list.

1

2

4

2. Enter customer information in the
    New Customer window.

5. All invoices for this customer are listed in the
    Transaction Details area.

voices for all your customers, 
tab.

3. The information for the new
    customer appears in the
    Customers & Jobs list.

 Use the Customer Centre to view customer data.
w Customer & Job to add a customer

6 5

3

4. Pick a customer name from the list and choose 
to create an invoice from the New Transactions 
menu. The customer information is entered 
automatically.
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Entering list information as you work
There are two basic methods you can use to enter list information in Reckon Accounts. You can enter account, 
customer, supplier, product, and service information before you enter transactions in Reckon Accounts, or you can 
enter this information “on the fly” as you use the product.

If you prefer to enter information as you use Reckon Accounts to perform your daily tasks, Reckon Accounts 
prompts you to immediately set up any entry it does not know about. For example, if you try to create an invoice 
for a customer named John Walker and you have not entered information about John Walker into Reckon Accounts, 
Reckon Accounts will prompt you:

Clicking Fast Add creates a new customer list entry for John Walker in the Customers & Jobs list and adds all the 
information you enter about the customer on the invoice form (billing address, payment terms, taxable status).

Clicking Set Up takes you to another window where you can enter information not covered by the invoice. For 
example, you could click Set Up to enter John Walker’s phone number, fax number, and credit limit.
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Writing cheques versus paying bills
In Reckon Accounts, you can manage your bills and payments in two ways:

Write cheques to pay bills now. Use the Write Cheques window and assign the amounts to appropriate expense 
accounts.This method is recommended when you don’t receive a bill, such as when you go to the store and write 
a cheque and then you need to record that expense in Reckon Accounts. You can also use Write Cheques to pay 
a bill as soon as you receive it, as long as you don’t need to track the bill.

Enter bills when you receive them and pay them later. Use the Enter Bills window to enter bills when you receive 
them. Then use the Pay Bills window to pay bills when they are due. You can set up Reckon Accounts to remind 
you to pay bills when they are due. Using this method, you keep your money in your business for as long as 
possible. You might still use a cheque to pay the bill, but this method enables you to track how much money you 
owe. And at any time, you can run reports to analyse unpaid bills for information such as which suppliers you owe 
money.

Note: Do not simply write a cheque in the Write Cheques window to pay bills that you entered in the Enter Bills window or the 
accounts payable registers.

The following figure illustrates the difference between writing cheques versus entering and paying bills.

Learning Reckon Accounts
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Reckon Accounts Workflow  |  Visual Overview
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Learning how to do essential Reckon Accounts tasks
The diagram to the left shows a visual overview of the essential tasks that most people use to run their company in 
Reckon Accounts. This chapter describes how to perform each of these tasks and offers important usage tips.

The tasks are written assuming that you want to set up all the information for your business (for example, customer, 
supplier, and account information) before you begin creating invoices, receiving payments, or paying your bills.

However, you might prefer to enter information as you need it. For example, you might create an invoice for a new 
customer and use Fast Add to enter the customer information “on the fly”. Either method works fine. You choose the 
method that works best for you.

Essential Tasks
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Setting Up Your Business  |  Preferences

Preferences: Modify Reckon Accounts for the way you work 

Set personal and company
preferences for each 
Reckon Accounts area. 

Choose a group from the 
preference list to set 
behaviour for other 
Reckon Accounts areas. 

Click General to set
general Reckon Accounts
preferences.

❷

❸
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Company preferences

Company preferences are global preferences 
that affect all users of the company file. Only the 
Reckon Accounts Administrator can set up or 
modify company preferences.

My Preferences

You can customise your workflow by setting 
personal Reckon Accounts preferences, such 
as using the Enter key instead of the Tab key to 
move between fields.

Setting Up Your Business

Did You Know?Changing Reckon Accounts for the way you like 
to work
You can modify Reckon Accounts in many ways to suit the needs of 
your business and your personal style of working. From the Reckon 
Accounts Preferences window, you can define preferences in over a 
dozen different categories.

For example, you can configure general preferences such as whether 
or not Reckon Accounts prompts you before editing or deleting a 
transaction, or which date Reckon Accounts uses for new transactions. 
Or, you can configure accounting-specific preferences such as how 
Reckon Accounts displays accounts and subaccounts.

To view and set preference options:

A Go to the Edit menu and click Preferences. 

B In the Preferences window, change any of the general Reckon 
Accounts preferences. These preferences determine how Reckon 
Accounts behaves.

C To display the preferences for another area of Reckon Accounts, 
click the appropriate category in the scroll list on the left. For 
example, to set preferences for reporting functions, click Reports & 
Graphs. 

D On the My Preferences tab for the particular feature area, enter 
the changes and settings you want. These settings affect only your 
Reckon Accounts sessions, not those of other users.
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E Do one of the following: 

 Click OK to close the Preferences window and save your changes. 

 Click another feature area in the scroll box to enter other preferences. Click Yes when prompted to save your 
changes.

F Click OK.
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Adding an Account
When you set up your company file, Reckon Accounts sets up certain 
accounts for you automatically. However, as your business grows 
or changes, you might need to add new accounts to your chart of 
accounts to better organise your finances. Or, you might need an 
account that was not provided during setup. For example, you might 
want to create expense accounts to track office supply purchases 
separately from advertising costs.

To add an account:

A Go to the Lists menu and click Chart of Accounts.

B Click the Account button and then click New.

C In the Add New Account: Select Account Type window, select the 
type of account you want to create and then click Continue.

Note: Refer to pages 65 and 66 for a description of the different types of 
income, expense, and balance sheet accounts.

D Enter the account’s name in the Account Name field. This name will 
appear on your company financial statements.

E If you want to make this account a subaccount of another account, 
select the Subaccount of checkbox. From the drop-down list, 
click the account that will be the higher-level account for this 
subaccount.

Accounts

There are two types of accounts:

 Balance sheet accounts track your assets and 
liabilities (such as bank accounts or accounts 
payable).

 Income and Expense accounts are used to 
track where your income came from and 
what you spent the money on, such as office 
supplies, rent, and utilities.

Refer to pages 65 and 66 for a description of 
the different Reckon Accounts accounts.

Chart of Accounts

A complete list of your business’ accounts and 
their balances. You use a chart of accounts 
to track how much money your company has, 
how much money it owes, how much money is 
coming in, and how much is going out.

It is recommended that you open a business 
current account for writing cheques as one 
of the first things you do when starting a new 
business.

Key Terms

Did you know?
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F (Optional) Enter a short description, note, bank account number, or credit card number, depending on the type of 
account you are adding.

G For balance sheet accounts, enter an opening balance based on the account’s balance as of your Reckon 
Accounts start date. Generally, you should enter any balance sheet balances as of the day before your start 
date. That way it’s all exactly correct at the opening of your start date. If you’re putting money into the account 
with a transaction, do not use the opening balance field, since this will create an additional transaction. If you’re 
not sure of the balance, you can leave the field blank and enter the information later. Click OK when finished.

H Click Save & Close or Save & New to add another account.

Why use Subaccounts?
When you need more detail about what’s going on in an account, you can divide the account into one or more 
subaccounts. Subaccounts let you track several related types of income or expenses independently yet keep them 
all under the “umbrella” of a single parent account. Subaccounts appear indented immediately below their parent 
account in your chart of accounts. If you create subaccounts, it’s best not to post anything to the “parent” account. 
For example, if your business has substantial advertising expenses, you might decide to divide your Advertising 
expense account into several subaccounts, such as Newspaper Ads, Signs, Yellow Pages Listing, and Direct 
Mailings.

For a brand new account
When you create a brand new account, leave the opening balance at zero. Its opening balance will be created 
automatically when you transfer funds from another account.

What type of account should I use?
There are two main types of accounts in the Reckon Accounts chart of accounts:

 Income and expense accounts
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 Balance sheet accounts

Income and Expense Accounts
Income and expense accounts track the sources of your income and the purpose of each expense. When you record 
transactions in one of your balance sheet accounts, you usually assign the amount of the transaction to one or more 
income or expense accounts. For example, not only do you record that you took money out of your current account, 
but you keep track of what you spent the money on (utilities or office supplies).

Account type Purpose

Income
Categorises money earned from normal business operations, such as product sales, service sales, and 
discounts to customers.

Other income
Categorises money your business earns that is unrelated to normal business operations, such as dividend 
income, interest income, and insurance reimbursements.

Expense
Categorises money spent in the course of normal business operations, such as advertising and promotion, 
office supplies, insurance, legal fees, payroll, charitable contributions, and rent.

Other expense
Categorises money your business spends that is unrelated to normal business operations, such as 
corporation taxes and penalties and legal settlements.

Cost of goods sold
Tracks the direct costs to produce the items that your business sells, such as cost of materials, cost of 
labour, subcontractors, and shipping.

Note: Reckon Accounts does not display balances for income and expense accounts in the Chart of Accounts. To see these balances, 
go to the Reports menu, click Report Centre, and then click the Company & Financial category. You can also select the income or 
expense account in the chart of accounts and click FastReport.

Setting Up Your Business
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Balance Sheet Accounts
Reckon Accounts provides 10 types of balance sheet accounts to choose from as you create and add to your Chart 
of Accounts. Use the type of account that best describes the type of data you are tracking.

Account type Purpose

Bank
Tracks money you have in your cash accounts. Create one for each cash account, such as petty cash, 
current, and savings.

Accounts receivable 
(A/R)

Tracks money your customers owe you on unpaid invoices. Most businesses require only the A/R 
account that Reckon Accounts automatically creates.

Other current asset
Tracks the value of things that you can convert to cash or use up within one year, such as prepaid 
expenses, employee cash advances, stock, and loans from your business.

Fixed asset
Tracks the value of significant items (consult your accountant for a minimum cash amount) that have a 
useful life of more than one year, such as buildings, land, machinery and equipment, and vehicles.

Other asset
Tracks the value of things that are neither Fixed Assets nor Other Current Assets, such as Goodwill, 
long-term notes receivable, and security deposits paid.



67

Setting Up Your Business

Account type Purpose

Accounts payable 
(A/P)

Tracks money you owe to suppliers for purchases made on credit. Most businesses require only the 
A/P account that Reckon Accounts automatically creates.

Credit card Tracks credit card purchases, bills, and payments. Create one for each credit card your business uses.

Other current liability
Tracks money your business owes and expects to pay within one year, such as tax or security deposits/
retainers from customers.

Long-term liability
Tracks money your business owes and expects to pay back over more than one year, such as 
mortgages, long-term loans, and notes payable.

Equity
Tracks money invested in, or money taken out of, the business by owners or shareholders. Payroll and 
reimbursable expenses should not be included.
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Setting Up Your Business  |  Adding Customers

 
Click New Customer & Job to add 
new customers to the list.

 
View the amount of money each 
customer owes you in the Balance 
Total column.

 
Click a customer’s name in the 
list to view the contact information 
and notes for that customer.

 
See all transactions for this 
customer in the transaction list, 
which can be sorted and filtered.
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Adding Customers
Customers are the lifeline of your business. By entering detailed 
information in Reckon Accounts about the people and companies to 
whom you sell your products and services, you can personalise their 
bills, send invoices easily, and quickly view the status of their accounts. 
You can add new customers at any time.

While typing in customer data for hundreds of customers can be a 
tedious task, if you use Microsoft Outlook, you can import your existing 
customer information into Reckon Accounts instead of entering it 
manually. Refer to the Reckon Accounts in-product Help for instructions 
on how to prepare your customer data file for importing into Reckon 
Accounts. 

To add a customer:

A Click the Customer Centre icon at the top of the Reckon Accounts 
window.

B Click New Customer & Job and then click New Customer.

C On the Address Info tab, enter all the data that you have about the 
customer, including their name, Invoice to and Ship to addresses, 
and additional contact information.

D Complete the Additional Info and Payment Info tabs, as 
appropriate.

Customers

Customers are the people or businesses to whom 
you sell your products or services -- that is, the people 
who pay you for what you do. Some businesses might 
refer to a customer as a client or member.

Adding jobs

If you are performing more than one job for a 
customer, you can track the jobs individually by 
adding new jobs under the customer’s name in the 
Customers & Jobs list. That way, you can create 
reports that show the income and expenses for each 
job. To add a job, click New Customer & Job and then 
click Add Job.

Importing customers

If you need to add several customers to your Reckon 
Accounts company file, consider using the Import/
Export functions to enter multiple customers at one 
time. For more information, see Reckon Accounts Help 
for importing lists.

Searching for customers

You can filter the Customers & Jobs list and Suppliers 
list to display only certain items. This is a useful 
way to find a particular list entry, or to display only a 
particular set of entries.

Key Term

Did you know?
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E If you want to add additional fields to the form, click Define Fields to customise the form.

F Click OK or Next (if you want to enter another customer).

You can also add customers as you perform your everyday tasks. For example, if you enter the name of a new 
customer when filling out an invoice, Reckon Accounts will prompt you to enter information about this customer. You 
can choose from two quick setup options:

 Fast Add -- Adds just the name to the list. You must add the details later.

 Set Up -- Enables you to enter additional information (such as a phone number, tax number, and alternate 
contact) to the list you choose.
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Setting Up Your Business  |  Adding Suppliers

 
Click New Supplier to add new 
suppliers to the list.

 
Click a supplier’s name in the list 
to view the contact information 
and notes for that supplier.

 
View the amount of money you 
owe each supplier in the Balance 
Total column.

 
See all transactions for this 
supplier in the transaction list, 
which can be sorted or filtered.
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Adding Suppliers
Reckon Accounts uses the supplier list to hold information about the people and companies you buy goods and 
services from to run your business; for example, this list could include the phone company, your office stationery 
supplier, and your Utilities provider. You can add new suppliers at any time.
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While typing in supplier data for hundreds of suppliers can be a tedious 
task, if you use Microsoft Outlook, you can import your existing supplier 
information into Reckon Accounts instead of entering it manually. Refer 
to the Reckon Accounts in-product Help for instructions on how to 
prepare your supplier data file for importing into Reckon Accounts. 

To add a supplier:

A Click the Supplier Centre icon at the top of the Reckon Accounts 
window.

B Click New Supplier.

C On the Address Info tab, enter all the data that you have about 
the supplier, including their name, address, and additional contact 
information.

D If you owe the supplier money as of your company’s start date, 
enter the amount in the Opening Balance field. 

E Click the Additional Info tab and complete the form.

F If you want to add additional fields to the form, click Define Fields 
to customise the form.

G Click the Bank Details tab and complete the form.

H Click OK or Next (if you want to enter another supplier).

Suppliers

Suppliers are any businesses or people from 
whom you buy or rent goods or services for your 
business -- office supplies, phone or computer 
services, or products that you sell. The tax 
agencies that you pay are also your suppliers. 
Nearly everyone you pay other than employees 
are suppliers.

Importing suppliers

If you need to add several suppliers to your 
Reckon Accounts company file, consider 
importing all your suppliers at the same time. 
Refer to the in-product Help for instructions on 
how to import lists.

Key Term

Did you know?
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You can also add suppliers as you perform your everyday tasks. For example, if you enter the name of a new supplier 
when paying a bill, Reckon Accounts will prompt you to enter information about this supplier. You can choose from 
two quick setup options:

 Fast Add -- Adds just the name to the list. You must add the details later.

 Set Up -- Enables you to enter additional information (such as a phone number, tax number, and alternate 
contact) to the list you choose.

Setting Up Your Business  |  Adding Items
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Adding Items
In Reckon Accounts, an item is anything that your company buys, sells, 
or resells to run your business. Items are your products, services, and 
things such as discounts and shipping and handling charges.

When you choose an item from the Item list, Reckon Accounts fills in a 
description of the line item and calculates its amount for you.

Reckon Accounts provides 9 different types of items, described in the 
table on page 77. Some items, such as service or inventory part items, 
help you record the services and products your business sells. Other 
items, such as the subtotal or discount items, are used to perform 
calculations on the amounts in a sale.

To add an item:

A Go to the Lists menu and click Item List.

B Click Item at the bottom of the list and then click New.

C Click the Type drop-down arrow and choose the type of item you 
want to create. (See table on page 77.)

D Enter an item name as you want it to appear on purchase and 
sales forms.

E Enter the description that you want to appear on sales forms when 
you use the payment item.

F In the Rate field, enter the amount you want to charge for the item.

Items

An item is anything that might appear as a 
line item on an invoice, including subtotals, 
discounts, and tax, as well as the products and/
or services that you sell. You enter items on 
your invoices and sales receipts. For example, 
a writing consultant might set up one item 
for editing services with an hourly rate, and 
another item for writing services with a different 
hourly rate. On an invoice, the items would be 
entered with the number of hours worked as the 
quantity.

While providing a quick means of data entry, 
items also handle the behind-the-scenes 
accounting. When you create an item you link it 
to an account. When the item is used on a form 
it posts an entry to that account and another to 
the appropriate accounts receivable, accounts 
payable, current, or other account.

Key Term
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G In the Tax Code list, select the appropriate tax code or create a new one. If you do not see the Tax Code list, you 
must turn the tax preference on in the tax area under Edit | Preferences.

H In the Account field, choose the account that is associated with this item. (In most cases, you will assign the 
item to an income account.)

I Click OK or Next (if you want to enter another item).
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Which Item Type Should I Choose?
Reckon Accounts provides 9 different types of items to help you fill out sales and purchase forms quickly.

Item Type Purpose

Service
Use for services you either charge for or purchase, like specialised labour, consulting hours, and 
professional fees.

Inventory part (available in 
Reckon Accounts levels Premier 
and above)

Use for goods you purchase, track as inventory, and resell.

Inventory assembly (available 
in Reckon Accounts levels 
Plus and above)

Use for assembled goods you build or purchase, track as inventory, and resell.

Non-inventory part
Use for goods you buy but don’t track, like office supplies, or materials you buy for a specific job 
that you charge back to your customer.

Other charge
Use for miscellaneous labour, material, or part charges, such as delivery charges, setup fees, 
and service charges.

Setting Up Your Business
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Item Type Purpose

Subtotal
Use for showing sum of all items above it on a form, up to the previous subtotal. Useful for 
applying a percentage discount or surcharge to multiple items.

Group
Use for associating a set of individual items that often appear together on invoices, purchase 
orders, and so on, so that all items in the group can be added to the form at one time.

Discount
Use to subtract a percentage or fixed amount from a total or subtotal. Do not use this item type 
for an early payment discount.

Payment
Use to record a partial payment you received at the time of a sale. It reduces the amount owed 
on an invoice.

Why item types are important
Although you can use items as a quick means of entering data, items fulfil a much more important Reckon Accounts 
role: to handle the behind-the-scenes accounting. 

When you create an item, you link it to an account; when the item is used on a form, it posts an entry to that 
account and another entry to the appropriate accounts receivable, accounts payable, current, fixed asset, or other 
account.

While items are easy to set up, you should spend some time deciding how they can best work for you before you 
start setting them up and using them. Use your current list of services and products as a starting point. Consider 
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how much detail you want on your invoices or statements and set up your items with that level of detail in mind. For 
example, if you are a seamstress who creates and sells home accessories, you can set up a single item and charge 
a flat rate for a certain size of couch pillow, or you can break that pillow down further into labour and materials.

Furthermore, Reckon Accounts provides many useful reports that break information down by the goods or services 
you purchase and sell. That way, you can quickly find out:

 How much income your items bring in 

 What you are spending to purchase items 

 How well you estimate the cost of items 

 How much time you spent on each type of job or item

Setting Up Your Business
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Setting Up Your Business  |  Setting up tax
How tax tracking works in Reckon Accounts

Assign 
Tax Codes 
to your 
items.

Reckon Accounts tracks your output tax 
and input tax in the Tax Liability 
account, which Reckon Accounts creates 
by default.

Invoice

Buy items

Enter Bills

Sell items

Fill in your tax return, and send 

your payment to your tax agency.
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Setting up tax
If you are registered to collect tax, you need to enable tax tracking in Reckon Accounts. Reckon Accounts then tracks 
the tax that your company pays on expenses, reclaiming it from the tax that you collect and pay to your tax agency.

Reckon Accounts supports the two most common tax schemes: Standard Accrual Tax Accounting and Cash Tax 
Accounting.

 Standard Accrual Tax Accounting scheme: you track tax on sales and purchases when you send an invoice or 
receive a bill, and very likely before you have received any money for these transactions from your customers.

 Cash Tax Accounting scheme: you pay and reclaim tax only on the basis of cash received and cash paid out by 
you. This scheme is meant to help smaller businesses with their cash flow. To qualify, your annual turnover must 
be below a certain value.

Important: You must follow the rules and regulations from your tax agency for collecting and paying tax.

Understanding how tax works in Reckon Accounts
You use tax codes on transaction forms to set how tax applies to the products and services that you buy and sell. For 
example, when you create an invoice, you assign an appropriate tax code to each line item on the invoice.

Each tax code is associated with one or both of a tax item for sales, and a different tax item for purchases. This lets 
Reckon Accounts properly track both output tax (from your sales) and input tax (from your purchases).

Reckon Accounts uses tax items to calculate and add tax charges when you make a taxable sale. When you set up 
a tax item, you assign a tax rate to it and associate it with the tax agency to which you pay the tax. After you enable 
and set up tax, Reckon Accounts applies the appropriate tax rate to the sale of your taxable items, based on the tax 
code.

Tip: Reckon Accounts sets up default tax codes, tax items, and your tax agency for you. These become available when you enable 

Setting Up Your Business
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tax, either from the Setup Interview or through the Preferences window.

Preferences: Set tax preferences

Verify that you have tax
turned on.

Choose settings that reflect
the way you manage tax.

❹

Setting up tax
If you need to make changes to how tax is configured, you need to know the following:

 Tax rates for the new tax situation that you need to handle.

 Tax agencies to which you pay the collected tax.

Setting up tax is a three-step process:

 Step 1:  Enabling tax in preferences
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 Step 2:  Setting your tax reporting period

 Step 3:  Entering an opening balance for your tax payable (what you owe)

Don’t forget to specify your Tax Rego ID (ABN) in the Company Information window. (Go to the Company menu and 
click Company Information.)

Tip: Reckon Accounts includes a Manage Tax window to help you complete your common tax tasks, like setting tax preferences, 
creating tax reports, and paying tax liabilities. To open this window, go to the Suppliers menu, click Tax Activities, and then click 
Manage Tax.

Step 1:  Enabling tax in preferences
In this procedure, you’ll turn on tax and then set up basic information about how you report tax to your tax agency.

To set up your tax payment schedule:

A Go to the Edit menu and click Preferences. 

B In the scrolling list on the left, click Tax.

C Click the Company Preferences tab. 

D For the question Do you track tax?, click Yes.

Step 2:  Setting your tax reporting periods
Your tax reporting periods are when and how often you need to file tax with your tax agency. You set this up in the tax 
supplier (i.e., the tax agency’s supplier) record. While Reckon Accounts creates the supplier record for you, you still 
have to specify the tax reporting period yourself.

To set up your tax reporting periods:

A Open the Supplier Centre (go to the Suppliers menu and click Supplier Centre).
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B In the lists on the left side of the screen, click the Suppliers tab.

C Double-click the supplier used to pay tax. Typically, this is “Australian Taxation Office”.

D In the Edit Supplier window, click the Tax Agency Info tab.

E In Period and Period Ending, select the schedule at which you file tax. For example, if you file tax four times a 
year at the end of March, June, September, and December, choose a Period of “Quarterly” and a Period Ending 
of “Mar/Jun/Sep/Dec”.

F Click OK to close the Edit Supplier window. 

Step 3:  Entering an opening balance for your tax payable (what you owe)
You need to enter an opening balance for your Tax Payable account (what you owe as of your Reckon Accounts start 
date). After your start date, your tax is included on your sales forms and entered into this account.

Caution: Do not do this if you entered all historical invoices or sales receipts dated before your Reckon Accounts start date. Your 
tax will already be included on them and posted to this account.

Default tax codes
When you enable tax Reckon Accounts sets up the following tax codes by default. In most cases, these will be all 
you’ll need.

Tax code Description Linked to Tax Item

ADJ Tax Adjustments
ADJ-P -- Purchases

ADJ-S -- Sales

CAF Cap. Acq. -- GST Free CAF
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Tax code Description Linked to Tax Item
CAG Cap. Acq. -- Inc GST CAG

CAI Cap. Acq. -- for making Input Taxed Supplies CAI

CDC Combined Cellar Door CDC Tax Group

CDG Cellar Door GST CDG

CDS Cellar Door WET CDS

EXP GST Free Exports EXP

FRE GST Free Supplies FRE

GST 10% GST GST

INP Input Taxed Sales INP

NCF Non-Cap. Acq. -- GST Free NCF

NCG Non-Cap. Acq. -- Inc GST NCG

NCI Non-Cap. Acq. -- for making Input Taxed Supplies NCI

WC Combined WET & WGST WC Tax Group

WET Wine Equalisation Tax WET

WGST GST on Wine Equalisation Tax WGST

Default tax items
When you enable tax Reckon Accounts sets up the following tax items by default. In most cases, these will be all 
you’ll need.

Setting Up Your Business
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Tax item Description Rate Agency Sales or Purchase

ADJ -- S Tax Adjustments (Sales) 10.00% Default S

ADJ -- P Tax Adjustments (Purchases) 10.00% Default P

CAF Cap. Acq. -- GST Free 0.00% Default P

CAG Cap. Acq. -- Inc GST 10.00% Default P

CAI
Cap. Acq. -- for making Input Taxed 
Supplies 0.00% Default P

CDG Cellar Door GST 11.90% Default S

CDS Cellar Door WET 18.98% Default S

EXP GST Free Exports 0.00% Default S

FRE GST Free Supplies 0.00% Default S

GST 10% GST 10.00% Default S

INP Input Taxed Sales 0.00% Default S

NCF Non-Cap. Acq. -- GST Free 0.00% Default P

NCG Non-Cap. Acq. -- Inc GST 10.00% Default P

NCI
Non-Cap. Acq. -- for making Input 
Taxed Supplies 0.00% Default P

WET Wine Equalisation Tax 29.00% Default S

WGST GST on Wine Equalisation Tax 12.90% Default S

CDC

(Tax Group)
Combined Cellar Door

CDG 11.90% +CDS 
18.98% 

= 30.87%
Default S
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Tax item Description Rate Agency Sales or Purchase

WC

(Tax Group
Combined WET & WGST

WET 29.00% +WGST 
12.90%

= 41.90%
Default S

Setting Up Your Business
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Setting Up Your Business  |  Setting Up Your Payroll

Setting up your Payroll
Paying employees is a big responsibility. You have to calculate gross and net pay, tax and superannuation, as well as 
track the liability payments you need to send to the Australian Taxation Office and benefit agencies.

Setting up Reckon Accounts Payroll 
Reckon Accounts includes step-by-step instructions that take you through setting up payroll for your business. You 
need to set up your payroll items, your employees, and set your employees’ year-to-date (YTD) amounts.
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Tip: Depending on the size of your company, payroll setup can take a long time to complete. Before you begin setting up payroll, 
we recommend you gather all of the information in the Payroll Setup Checklist.

The following sections describe common activities you will perform during payroll setup.

Setting up Payroll Items
You add payroll items to payroll payments the same way you add items to invoices. Payroll items track amounts 
such as wages you pay and taxes you deduct from your employees’ payroll payments. There are payroll items for 
commission, taxes, other additions and deductions, and employer-paid expenses. You can assign these payroll items 
to different accounts as needed.

By default, Reckon Accounts creates common payroll items that you’ll need, such as tax deductions and 
superannuation. However, you may need to add other payroll items for your own company.

To create a payroll item:

A Go to the Lists menu and click Payroll Item List.

B From the Payroll Item menu button, choose New. 

The Payroll Item Wizard opens.

C Choose the type of payroll item you want to create and click Next:

 Wage: Money you pay to employees for salaries, hourly wages, commissions, and Paid Parental Leave

 Addition: Money you pay to employees above their base earnings, such as a bonus

 Deduction: Money you deduct from your employee other than taxes, such as life insurance

 Company Contribution: Company-paid benefits for your employees

 Superannuation Contribution: Company and employer contributions

D Follow the onscreen instructions. When you’re done, click Finish.

Setting Up Your Business
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Entering year-to-date amounts for your employees
If you begin using payroll part way through the current tax year, you must enter year-to-date amounts for each 
employee that you’ve paid thus far in the tax year. In Australia, PAYG is calculated on a cumulative basis, so Reckon 
Accounts needs to take into account an employee’s total pay and tax amounts for a given tax year in order to be 
able to deduct the right amount of tax from his or her pay.

You can use the Year-to-Date Wizard to help you enter year-to-date amounts for your employees.

Follow the steps below to summarise and enter the payroll payments you processed for each employee from the 
beginning of your financial year (e.g., in Australia this is July 1) to the date that you started using Reckon Accounts 
Payroll.

To summarise and enter year-to-date amounts for each employee:

A From the Employees menu, click Payroll Setup, then click the YTD Amounts tab. 

B Follow the onscreen instructions until you get to the Employee YTD summary information window. Select an 
employee from the list and click Enter Summary. 

The YTD Adjustment window opens.

C Enter the details of the year-to-date payroll amounts for this employee. 

We recommend that you create one entry to summarise the payroll payments that you’ve paid to this employee 
thus far.

D Click OK, then select the next employee.

E Click Finish when you are done, or if you need to enter prior payroll liability payments, click Next and refer to the 
steps below.

To learn more about entering year-to-date amounts, see the in--product Help.
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To enter prior payroll liability payments:

A Open the Year-to-Date Wizard as described in the steps above.

B Follow the onscreen instructions until you get to the Summarising prior liability payments window.

C Click the Prior Payments button to enter a summary of all the taxes and liability payments you’ve made to the 
government.

Payroll Setup Checklist
Before you begin setting up your payroll, you should gather the information listed in the following table. You can 
find this information in your own records, from your accountant or Reckon Accredited Partner, or from government 
agencies.

Information Reckon Accounts needs Where to find it

Tax office number and reference Your accountant or company records

Current tax tables covering payroll withholdings Your tax agency or download from Reckon

How you pay your employees and directors (hourly wages, salaries, 
and/or commissions) Your accountant or company records

How often you pay your employees Your accountant or company records

Additions you make to your employees’ pay that increases their 
earnings base (bonus payments, statutory payments, etc.) Your accountant or company records

Setting Up Your Business
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Information Reckon Accounts needs Where to find it

Deductions you make to your employees’ pay (student loan 
repayments, union dues, employee loans, health insurance, etc.) Your accountant or company records

Payroll expenses that your company pays Your accountant or company records

Employee personal information (Tax File Number, date of birth, 
contact details) Your accountant or employee records

Employees’ rate of pay and payroll payment additions, deductions, 
and employer contribution amounts Payslips, reports, or your accountant

If paying using direct deposit, employee’s bank or building society 
details (account number, name of account holder, bank name and 
address)

Employees

Holiday and personal leave accruing policies and amounts Existing payments, reports

Total employee payroll amounts that you’ve paid out so far this 
payroll year up to the date you start using Reckon Accounts, 
including amounts withheld from payroll payments, commissions, 
and bonuses

Copies of employee payroll payments, payslips, previous 
accounting software or service provider, reports, your 
accountant or company records 

If you are already operating payroll, total amount of PAYG income 
tax owed to your tax agency as of your start date 

Previous accounting software or service provider, 
accountant or company records 
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Select a payroll schedule 
that you have set up.

Enter employee basic earnings 
information.

Set up the employee’s tax 
information.

Enter how much personal 
leave and how many holidays 
the employee has accrued and 
used thus far.

Enter employee benefits and 
deductions.

If paying by direct deposit, 
click the Direct Deposit button 
and enter the employee’s bank 
account information.

Click the Raises & Promotions
button to enter a raise or 
promotion or historical record 
using Employee Organiser.

Enter additional employee 
information including super 
fund details such as name and 
current rate.
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Setting up Employees
To process payroll payments and prepare tax documents for your 
employees, you need to enter specific information about each of your 
employees in Reckon Accounts.

Refer to the Payroll Setup Checklist on page 91 for a list of employee 
information to gather.

To set up an employee’s personal information: 

A Click the Employee Centre icon at the top of the Reckon Accounts 
window.

B Click New Employee.

C On the Personal tab, fill in the form.

D Click the Address and Contact tab, fill in the form, and then click 
OK.

E When prompted to set up the employee’s payroll information, click 
Leave As Is. Or, continue with the instructions below.

To set up an employee’s payroll information:

A Click the Employee Centre icon at the top of the Reckon Accounts 
window.

B Click the Employees tab and then double-click the employee’s 
name.

Setting Up Your Business

Earnings Base

An earnings base is the wages or earnings 
due to an employee before any deductions are 
made. It is also referred to as gross pay or 
taxable income. An employee's earnings base 
can include wages, salaries, overtime, bonuses, 
and commission. Reckon Accounts uses the 
earnings base to work out payroll withholding 
amounts, such as tax.

Directors

A director is a person who, traditionally, 
manages the business of the company on a day-
to-day basis.

For more information on directors, refer to the 
in-product Help.

Hire an Employee Wizard

The Hire Employee wizard guides you through 
the process of hiring an employee.

Go to the Employees menu, choose Employee 
Organiser, and then click Hire Employees.

For more information, refer to the in-product 
Help.

Key Terms
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C From the Change tabs drop-down list, click Payroll and Compensation Info.

D Fill in the Payroll Info form.

E Click the Taxes button. Fill in the form, based on the employee’s tax information.

F Click the Leave Details button. Fill in the form to specify how personal leave and holidays are accrued.

G If you pay the employee using online banking, click the Direct Deposit button to set up the employee’s bank 
account information.

H Click the Super Details button. Fill in the form to set up the employee's superannuation information.

I Click OK.

Once you’ve set up your employees, refer to “Paying Employees” on page 122 to learn about paying them.
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Creating an Estimate
You can use the estimate form to prepare estimates, bids, quotes, or proposals for your customers. You can change 
the title “Estimate” to anything that suits your business.

Note:  Estimates are available in Reckon Accounts levels Premier and above.

Filling in the estimate is similar to creating an invoice. And when it’s time to bill your customer, you can create the 
invoice directly from the estimate by clicking Create Invoice on the estimate’s toolbar. Reckon Accounts then creates 
the invoice, with all the information from the estimate filled in. Later, you can create reports that compare your 
estimated costs and revenue against your actual costs and revenue to see how accurate your estimates are.

To create an estimate:

A If necessary, turn on Estimates (described below), if you didn’t do this during the Setup Interview.

B Go to the Customers menu and click Create Estimates.

C Enter the name of the customer or job.

D Select an estimate template from the Template drop-down list.

E Fill in the estimate form.

F Click Print.

G Save the estimate.

To turn on the estimates feature:

A Go to the Edit menu and click Preferences. 

B Click Jobs & Estimates in the list on the left and then click the Company Preferences tab. 

C Click Yes to the question, “Do You Create Estimates?” 
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D To have Reckon Accounts warn you when you try to record an estimate with the same number as the existing 
estimate, select the Warn about duplicate estimates numbers checkbox.

E If you do progress invoicing:

 Make sure Yes is selected in response to the question, “Do You Do Progress Invoicing?”

 Specify whether you want line items that have zero amounts to print on your progress invoice

F Click OK.

Money In
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Creating an Invoice
When your customers don’t pay you in full at the time you provide your 
service or product, or when they pay in advance, you need to track how 
much they owe you. You can use an invoice to help you keep track of 
what your customers owe you (or your “accounts receivable”).

Invoices list all the details about the sale, including the services you’re 
providing or the products you’re selling (your “items”). Invoices also 
show the quantity and price or rate of each item. If you need to make 
automatic adjustments to prices (for example, discounts or markups), 
invoices will work for you.

Note: If your customers pay in full at the time of purchase, do not create an 
invoice. Instead, create a sales receipt, described on page 103.

To create an invoice:

A Go to the Customers menu and click Create Invoices.

B In the Customer:Job drop-down list, click the name of the customer 
or job.

C Click the Template drop-down arrow and then click the invoice 
template you want to use.

D Click the Terms drop-down arrow and then click the sales terms 
that apply to this customer.

E In the lower part of the form, enter each of the items (including the 
proper quantity) that the customer has purchased.

Key Term

Money In

Estimate

An estimate is a form you use to itemise the 
work you propose to do or the products you 
intend to sell to a customer. Your company 
might use a different term, such as bid, grant, or 
proposal. Estimates are optional, not mandatory, 
for all businesses.

Using sales orders

In Reckon Accounts levels Premier and above, you 
can create sales orders to help you keep track 
of items that your customers have ordered but 
you have not yet delivered to them, for example 
because you do not have them in stock.

Refer to the in-product Help for instructions and 
tips on how to use sales orders.

Did you know?
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F Click Print on the toolbar to print the invoice now. Optionally, you can select the To be printed checkbox to print 
the form later.

G Save the invoice.

Tip: You can customise your invoices (or any other sales form) for your business. Click Customise to open the Basic 
Customisation window, where you can add your company logo, change fonts and colours, and access more advanced options.
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Entering Sales Receipts
When your customers pay in full at the time they receive your service or 
product, you don’t need to track how much they owe you. However, you 
might want to record the sale, calculate its tax, or print a receipt for the 
sale. In these cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts include 
hairdressers, beauty salons, and DIY shops.

Note: If you need to track how much a customer owes you or you do not receive 
full payment at the time of the transaction, do not use a sales receipt. Instead, 
create an invoice, described on page 101.

To enter a sales receipt:

A Go to the Customers menu and click Enter Sales Receipts.

B Fill in the top part of the form, including the Customer:Job, Date, 
and Payment Method.

C Click the Template drop-down arrow and then click the sales receipt 
template you want to use.

D In the bottom part of the form, select or enter the items purchased.

E Save the transaction.

Key Term

Money In

Invoice

An invoice is the form you use to charge 
customers for the products and services they 
purchase from you.

You can create an invoice letter directly from the 
invoice form by clicking the Letters button on the 
Create Invoices toolbar. Refer to the in-product 
Help for more detailed information about this 
feature.

Did you know?
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Receiving a Payment 
When you receive money from a customer, you must receive the 
payment in Reckon Accounts so Reckon Accounts can record the 
transaction and mark the invoice as being paid. When you receive 
a payment, the accounts receivable records are updated, and the 
payment is ready to be deposited into an account.

To receive a payment:

A Go to the Customers menu and click Receive Payments.

B Fill in the top portion of the form, including the customer’s name, 
the payment amount, payment method, and the date on which the 
payment was received.

C Check the column to the left of the invoice to which you want to 
apply the payment. You might be asked to decide how to apply the 
payment for one of the following scenarios:

 Overpayment can become a credit or refund

 Underpayment can be left as is or written off

 Customer has unused credit to be applied

 Customer has available discounts

Did You Know?

Money In

Sales Receipt

A sales receipt is the form you use when you 
make a sale for which you receive full payment 
at the time of the sale. Sales receipts can 
include payments by cash, cheque, or credit 
card.

You can also use a sales receipt to create a 
summary of sales income and tax owed. You 
can summarise daily or weekly sales on a sales 
receipt.

Did you know?
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D Choose the appropriate selection and you should see your choices reflected in total amounts for selected 
invoices.

If the customer has a discount or available credits, you can choose how to apply them.

E Save the payment.
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Making a Deposit
When you receive a payment from a customer, you can either deposit 
the payment into a bank account immediately, or you can wait until a 
later time to make the deposit.

To make a deposit:

A Go to the Banking menu and click Make Deposits.

B In the Payments to Deposit window, select the payments that you 
want to deposit and click OK.

C In the Make Deposits window, click the Deposit To drop-down arrow 
and then click the account to which you want to deposit the funds.

D Verify the date and the list of payments to deposit, making updates 
as necessary.

E If you want to receive cash back from this deposit, fill in the Cash 
Back fields at the bottom of the form.

F If you want to print a deposit slip or deposit summary, click Print.

G Save the deposit.

Note: Just because you’ve recorded the deposit in Reckon Accounts doesn’t 
mean that you’ve actually made the deposit and that the money is available. You 
still need to physically deposit the money at the bank.

Key Term

You can set a preference so that payments 
received:

 Automatically go to the undeposited funds 
account

 Automatically get calculated and applied as 
you select invoices in the list

Go to the Edit menu, click Preferences, and then 
click the Company Preferences tab in the Sales 
& Customers area to set this preference.

Money In
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Paying Bills
As you purchase equipment, supplies, products, or services to run your business, you will also receive bills that 
need to be paid. Entering these bills in Reckon Accounts enables you to not only track information about your 
purchases, but also to pay these bills. Reckon Accounts remembers all of your unpaid bills, enabling you to easily 
choose the bills you want to pay. Reckon Accounts then writes and saves the cheques or credit card charges or 
sends the online banking payment instructions, depending on the payment method you choose.

Note: Before paying a bill, be sure you read the section “Writing cheques versus paying bills” to make sure you are using the correct 
payment method.

To enter a bill:

A Go to the Suppliers menu and click Enter Bills.

B In the Supplier field, choose or enter a new supplier.

Note: If an open purchase order exists for this supplier, you are prompted to receive against it. Click Yes to receive against one 
or more purchase orders; then, in the Open Purchase Orders window, click each purchase order that contains items you’ve 
received and are being billed for.

C In the Amount Due field, enter the amount of the bill.

D Fill in the Date, Ref. No., Terms, and Memo fields as necessary.
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E For expenses (money you spend to run your business, such as 
utilities), assign the invoice to one or more expense accounts on 
the Expenses tab.  
For items (products or services your business buys), edit items that 
were entered from your purchase order or enter new items on the 
Items tab.

F Click Save & Close or Save & New to save the transaction.

To pay a bill:

A Go to the Suppliers menu and click Pay Bills.

B All outstanding bills are displayed. To limit the number of bills 
displayed, click Due on or before and then click the due date for the 
bills you want to display.

C Specify the Payment Account, Payment Method, and Payment Date.

D Click Pay Selected Bills to complete the transaction.

Do not use the Write Cheques window to write a 
payroll payment, pay your payroll liabilities, pay 
tax, or pay bills you’ve already entered in the Pay 
Bills window.

Refer to the in-product Help for more information 
on how to make these types of payments.

Paying employees
Refer to page 122 for instructions on paying 
employees.

Paying bills
You don’t need to use the Pay Bills window to 
pay your bills. You can enter cheques, credit 
card payments, and cash expenditures directly in 
the appropriate account register. However, if you 
enter bills using either the Enter Bills window or 
the Accounts Payable register, you must use the 
Pay Bills window for your bill payment. Do not 
use the Write Cheques window to pay a bill that 
you’ve entered with either of these methods.

Money Out

Did You Know?
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Writing Cheques
You can write a cheque for any kind of expense that you track with 
Reckon Accounts expense accounts and for non-inventory part, service, 
and other charge items. If you are using inventory or purchase orders, 
you can write cheques for inventory part items too.

Note: Before writing a cheque, be sure you read the section “Writing cheques 
versus paying bills” to make sure you are using the correct payment method.

To write a cheque:

A Go to the Banking menu and click Write Cheques.

B Click the Bank Account drop-down arrow and then click the account 
from which you want to write the cheque.

C Fill in the onscreen cheque as you would a paper cheque.

D Itemise your expenses (shipping charges, taxes, or other expenses 
not associated with any one item) on the Expenses tab.

E If you are purchasing items for your stock, enter the items on the 
Items tab.

F Save the transaction.

To find and print a single cheque:

A Load the blank cheque form into the printer.

B Go to the Banking menu and click Write Cheques.

C Click the Find button and search for the cheque you want to print.

You should not use the Write Cheques window 
to write a payroll payment, pay your payroll 
liabilities, pay tax, or pay bills you’ve already 
entered in the Pay Bills window.

Paying employees
Refer to page 122 for instructions on paying 
employees.

Money Out

Did You Know?
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D Double-click to view the cheque you want to print.

E Click Print.

F In the Print Cheques window, choose the options you want and click Print.

Note: To learn how to print multiple cheques at the same time, refer to the in-product Help.
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Issuing Credits or Refunds
Use an adjustment note to record a credit when a customer returns items and you’ve already recorded an invoice, 
customer payment, or sales receipt. You can also use an adjustment note for an overpayment.

To enter an adjustment note or record a return:

A Go to the Customers menu and click Create Adjustment Notes/Refunds.

B In the Customer:Job field, click the customer and job for which you are creating the adjustment note or refund 
cheque.

Note: If you have created more than one job for the customer, be sure to assign the adjustment note to the correct job. You can 
apply the adjustment note only to the same job for which it was created.

C Click the Template drop-down arrow and then click a template.

D Enter the items being returned in the line item area.

E Describe the reason for the adjustment and enter the quantity and rate, if applicable.

F (Optional) Enter a memo for this transaction.

Note: The memo does not print on the adjustment note, but it does appear in the Accounts Receivable register and in the 
customer register.

G Indicate whether you want to print or email the adjustment note to the customer.

H Save the adjustment note.
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I In the Available Credit window, choose how to use the credit. You 
can:

 Retain as an available credit

 Give a refund

 Apply it to a tax invoice

Note: Reckon Accounts enters a negative amount in your Accounts 
Receivable register for the adjustment note.

Adjustment note
A document that notifies a customer that you 
have reduced the customer’s balance (for 
example, when a customer cancels a sale, 
returns something, or overpays).

Did You Know?

Money Out
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Paying Employees
Your employees can be paid weekly, fortnightly, half monthly, monthly, or four weekly, and you can create their 
payments using cash, cheques or direct deposit. The employee’s tax is calculated automatically using the tax code 
that you entered in the employee’s profile.

Note: Before you begin paying your employees, ensure that your payroll is set up completely and correctly in Reckon Accounts. 

The following steps create payments for unscheduled payroll. If you want to use payroll schedules, see the sidebar 
to the right.

To create payroll payments:

A Click the Payroll Centre icon.

B In the Payroll Centre, click the Pay Employees button.

C Select the employee or employees you’re creating the payroll payment for.

D Verify that the Payment Date and Pay Period Ends date are correct.

E Click the Bank Account drop-down arrow to choose the account that Reckon Accounts uses to record this 
transaction.

F Click each employee’s name to open the Review or Change Payroll payment window by clicking Open Paycheque 
Detail. Make any necessary changes and click Done.

G Click Continue.

H Review the payroll payment information in the Review and Create Payroll Payments window.

I Click Continue.

J Click Create Payment.
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Using Payroll Schedules
A payroll schedule defines when you should run 
your payroll so that you can pay employees on 
their pay day. You can use payroll schedules 
to group together employees in whichever way 
makes the most sense for you to your business. 
However, all employees grouped in the same 
payroll schedule must have the same pay 
frequency (weekly, fortnightly, monthly, and so 
on).

If you want to use payroll schedules, click the 
Payroll Centre icon. From the Pay Employees 
section, click Set Up Your Payroll Schedule. 
After you create a new payroll schedule, you can 
assign employees to it.

To run a scheduled payroll, go to the Employees 
menu, click Pay Employees, and then click 
Scheduled Payroll. In the Pay Employees section, 
click to select the payroll schedule you want to 
run and then click Start Scheduled Payroll.

For more information, see the in-product Help.

Money Out

Did You Know?K In the Confirmation and Next Steps window that appears, click Print 
Cheques or Print Payslips, or both.

L After printing your payroll payments or payslips, click Close.
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Click More… for details 
about content, dates, and 
customisation.

3

Click the thumbnail report
icon to view a sample of 
a report.

3

Report choices displayed in
the window are based on the
category you choose. 2

View detailed Help topics to
learn how to use and modify 
reports.
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Using Reports to see how your business is doing
One of Reckon Accounts’ most robust features is its ability to generate 
data-rich reports about your business. Everything you enter in Reckon 
Accounts can be found and generated into a report.

Reckon Accounts comes with dozens of prepared reports that you can 
run. You can use the Report Centre to learn about Reckon Accounts 
reports and locate the ones that contain the information you need. 
Once you’ve found a report, you can change its date range, customise 
the way it looks, print a copy of it, export it to Microsoft Excel, or 
display it on your screen. 

To find and display the right report:

A Click the Report Centre icon at the top of the Reckon Accounts 
window. 

B Click a report category from the list on the left. Reports for the 
selected category are displayed on the right.

C From the report list, you can view a thumbnail picture of the report 
by moving your mouse over the thumbnail icon . To learn more 
about a specific report, click the More link. The in-product Help 
window opens with information about the data and specific ways to 
customise the report.

The Report Centre includes its own Learning 
Centre, where you can find detailed information 
about how to run, modify, and manage reports. 
You can view the Report Centre Learning Centre 
by clicking the Learning Centre link in the top-
right corner of the Report Centre.

Managing Your Business

Did You Know?
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D When you find the report you need, click its name to view the report.

Tip: In addition to the powerful reports available in the Report Centre, you can also use the Reckon Accounts Centres to 
get a quick snapshot of how your business is doing and the status of your relationships with your customers, suppliers, and 
employees. For example, from the Centres you can easily see all of your unpaid bills, all of the invoices that your customers 
haven’t paid, and the detailed history of each of your customers and suppliers. For more information about the Reckon 
Accounts Centres, refer to “Reckon Accounts Centres” in the in-product Help.

How to Use Reports to Find the Information You Want
The Reckon Accounts Report Centre describes all the available reports. Here are 10 common questions that people 
ask and the Reckon Accounts report you can use to find the answer.

Item Type Purpose

How much money did my company make or lose over a specific period of time? Profit & Loss Standard 
(In Company & Financial)

Which invoices or statement charges haven’t been paid and when are they due?
Open Invoices 
(In Customers & 
Receivables)

How much does my company owe each supplier and are any payments overdue? Unpaid Bills Detail 
(In Suppliers & Payables)

What is the value of my company (its assets, liabilities, and equity), and where can I see the 
total balance for each type of account?

Balance Sheets 
(In Company & Financial)
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Item Type Purpose

What is the recent activity in all my company’s accounts, with beginning and ending balances 
for each account?

General Ledger 
(In Accountant & Taxes)

What are the total sales for each customer and job? Sales by Customer Summary 
(In Sales)

Which items and/or services bring in the most/least income? Sales by Item Summary 
(In Sales)

What are my company’s total expenses for each supplier?
Expenses by Supplier 
Summary 
(In Company & Financial)

Where is the information I need for my income tax forms?
Income Tax Summary 
Income Tax Detail 
(In Accountant & Taxes)

For my company’s total sales, how much is taxable, at what rate, and how much tax is 
currently due to be paid?

Tax Liability 
(In Suppliers & Payables)

Managing Your Business
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Memorising a report for reuse
Whenever you change the settings for a report (modify it), you can memorise the report with the new settings and 
save it in the Memorised Report List. Then, when you want to create a similar report, you can click the Memorised 
Report List to find it.

Note: Reckon Accounts memorises the report settings, not the data in the report. When you display a memorised report, it applies 
the settings you memorised, but displays the latest data. For example, if the report date is set for the period Last Month and you 
memorise the report in September but recall it in December, the recalled report will have data for November, not August.

To memorise a report:

A Click the Report Centre icon at the top of the Reckon Accounts window. 

B Open the report you want to modify and save. 

C After you have customised a report, click Memorise at the top of the report.

D If you have changed an existing memorised report, indicate whether you want Reckon Accounts to replace the 
earlier report (under the same name) or create a new memorised report (under a new name).

E In the Memorise Report window, enter a title for the report.

F If you want to assign the report to a memorised report group, choose Save in Memorised Report Group and 
choose the group from the drop-down list. (You must already have the group set up on your Memorised Report 
List. You cannot create a new group here.)

G Click OK.
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Tip: When you create a report, you can change the way it looks (reformat it). You can change the fonts, change the header and 
footer, and resize the columns. 

You can also move and sort the data that the report contains. For example, you can add or delete columns, sort by columns, 
move columns, change how numbers display, change how transactions sort, and change the subtotal groupings.

For more information about how to modify the look and content for a report, refer to the in-product Help.

Other add-ons to help you manage your business
Reckon’s add-ons enable you to streamline management of your business and automate essential business 
activities. They offer easy-to-use, tightly integrated solutions that will enable you to manage your business efficiently 
and with confidence.

They include:

 Super Data

 Stationery

 Credit Card Payments

To learn more about these business solutions, visit the Products and Services areas of our website at  
www.reckon.com

Managing Your Business
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What's New In Reckon Accounts
To find out what’s new in Reckon Accounts, please visit the below link:

To view the latest changes, please visit the below link:

http://redirect.reckon.com.au/ReckonAccounts/whats-new
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Contacting Reckon
If you can’t solve a problem you’re experiencing with Reckon Accounts, you can ask our Community for help. You can also 
get help by telephone or email. Reckon also provides a website, (https://www.reckon.com/au/support/), which includes a 
database of support articles (Knowledge Browser) as well as contacts for Reckon Accredited Partners.

Fee based services
Reckon offers a number of support plans to meet your individual needs.

 Data Recovery: If your Reckon Accounts data file becomes damaged, we can provide data recovery service, which is 
available for a fee. 

 Password removal: If you forget your Administrator password, we can remove your password so you can access 
your important data, a service that is also available for a fee. 

Reckon Community
Find answers from our expert users, partners and Reckon staff. 

Link: https://community.reckon.com/reckon

Reckon's Accounts website
The Reckon Accounts website, (www.reckon.com), is the official site for Reckon Accounts users. You can get answers to 
many Reckon Accounts questions, important updates, and access to help through it. If you have an Internet connection, 
you can access the Reckon Accounts website directly from the Help menu in Reckon Accounts.
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Reckon Accredited Partners
Developing a strong, knowledgeable network of professionals is an important part of our commitment to delivering 
exceptional support to our Reckon Accounts customers. Whatever your individual needs, Reckon has an expert to help.

The Reckon Accredited Partners referral service is free. The professional you select will provide you with information about 
their fees.

If you are an accountant, bookkeeper, or computer consultant, consider becoming a member of this unique community. 
To find a Reckon Accredited Partner, or to become one yourself, visit the Reckon website.  Details for contacting Reckon 
Australia are provided below.

To find a Partner near you, please visit this link: https://partnersearch.reckon.com

Talking to a technical support representative
Be prepared when you call

If you need to call for assistance, you will get an answer quicker if you:

 Make sure you have registered your copy of Reckon Accounts and have your registration number and customer ID 
number ready. (It’s a good idea to have written this down in the front of this guide following registration.) To display 
your registration number, go to the Help menu and click My Licence Information.

 Are at your computer with Reckon Accounts installed. 

 Try to remember the windows you opened and the tasks you did before encountering the problem. Know the exact 
wording of any message that appeared on the screen.

 Have your company file set up for multiple users who have access to different areas of Reckon Accounts, as you’ll need 
to have access to most of the software. You might also want to switch to single-user mode.

 Have a pencil and paper handy to take notes.
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 Have the following information ready when you call:

 Model of computer and amount of memory (RAM) and hard disk space

 Accessory manufacturer, type and model (for example, monitor or printer)

 Operating system version

 Network configuration and software version

Solving problems on your own

Note: We recommend you back up your data before you start solving your problems.  For more information, see the in-product Help.

Guidelines for solving typical problems

Use the following examples as a guide to solve the problems you have.

Try the procedure again

Start at the beginning.  Examine windows where you filled in fields to be sure you are asking the program for what you 
want.

For example, if invoices you just entered are not showing on your Profit and Loss statement, you should ask questions such 
as:

 Does the date of the report include those invoices?

 Do the invoices appear if you change the report from cash to accrual basis?

 Does this problem occur with only invoices for one particular customer?

 Have you changed any filters on the report?  (Try to create a new report from scratch to see if the problem is solved.)
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Try a related procedure

For example, if you have a printing problem:

 Ensure the printer is working by trying to print something else.  If you have trouble printing cheques, try printing a 
report.  If you can’t print one of the sales forms, try printing a similar form.

 If you can’t print from Reckon Accounts, try printing from another program such as Microsoft Notepad.  If 
nothing prints from Notepad, you know the problem is related to the printer, not the software.  Check the printer 
connections, printer driver, print queue and so forth.

Think about what has been changed

If something used to work but no longer does, think about what changed.

 Have you changed or added other programs on your computer?

 Have you added a new printer?

 Have you moved the Reckon Accounts company file to a new location?

 Have you changed a setting in the Preferences window?

If the program “hangs” or locks up

There are a number of reasons why your system may freeze while using Reckon Accounts.  Try restarting your 
computer.  If restarting doesn’t help, go through the following list of questions and take any related action:

 Does your computer system or network meet the minimum requirements necessary for Reckon Accounts?  (See 
“System requirements” on page 7).

 Are you making the best use of available system resources by shutting down other programs that are running?  
(Check for programs that may be running in the background without your knowledge.)

 Do you have enough hard disk space available? (This is a common problem for those working in a multi-user, 
peer-to-peer network situation.)
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 Do you have any conflicts with sound or video drivers?

Note:  If you encounter system freezes while using Reckon Accounts, you may want to call for technical support.

Reckon Contacts
 Australia: http://redirect.reckon.com.au/ReckonAccounts/contact-au

 New Zealand: http://redirect.reckon.com.au/ReckonAccounts/contact-nz



Licence Agreement
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Reckon Accounts Licence Agreement
Click on the below link to view the Terms and Conditions:

 Australia: http://redirect.reckon.com.au/ReckonAccounts/terms-au

 New Zealand: http://redirect.reckon.com.au/ReckonAccounts/terms-nz 



Your important reference numbers
Customer ID:

Customer PIN:

Installation Key Code:

You will need these numbers for re-registration purposes. Please have these numbers on hand when contacting us.

Installation     User Product Key  Licence Key
PC 1
Example Reception 10030-59821-00858-381 36934-42890-33878-21990

PC 1

PC 2

PC 3

PC 4

PC 5



General Key
To start Reckon Accounts without a Ctrl 

(while 
opening)

To suppress all open windows, 

Accounts (chart) icon, then…

Alt 
(while 
opening)

Display product information about 
your Reckon Accounts version

F2

Close active window Esc or Ctrl+F4
Record (when black border is 
around OK, Save and Close, Save 
and New, or Record)
Record (always) Ctrl + 

Dates Key
Next day + (plus key)
Previous day - (minus key)
Today T
First day of the Week W
Last day of the weeK K
First day of the Month M
Last day of the montH H
First day of the Year Y
Last day of the yeaR R
Date calendar Alt + down       

arrow ( )

Editing Key
Edit transaction selected in register 
or list

Ctrl + E

Delete character to right of 
insertion point

Del

Delete character to left of           
insertion point

Backspace 
( )

Delete line from detail area Ctrl + Del

Accounts Business Range Keyboard Shortcuts
Insert line in detail area Ctrl + Ins
Cut selected characters Ctrl + X
Copy selected characters Ctrl + C
Paste cut or copied characters Ctrl + V
Increase cheque or other form 
number by one

+ (plus key)

Decrease cheque or other form 
number by one

- (minus key)

Ctrl + Z

Help Window Key
Display Help in context F1
Go to next Help topic Tab
Go to previous Help topic Shift + Tab 
Display selected topic

Activity Key
Open account list Ctrl + A
Write new cheque Ctrl + W
Copy cheque transaction in register Ctrl + O
Open Customer Centre (Customers 
& Job list)

Ctrl + J

Edit lists of registers Ctrl + E

letters of name and press Tab, 
abc Tab

Find transaction Ctrl + F
Go to register of transfer account Ctrl + G
History of A/R or A/P transaction Ctrl + H
Create invoice Ctrl + I
Open list (for current drop-down 
menu)

Ctrl + L

Memorise transaction or report Ctrl + M
Open memorised transaction list Ctrl + T

New invoice, bill, cheque or list item 
in context

Ctrl + N

Paste copied transaction in register Ctrl + V
Print Ctrl + P
FastZoom on report
FastReport on transaction or list item Ctrl + Q
Open split transaction window in 
register

Ctrl + S

Show List Ctrl + L
Use list item Ctrl + U
Open transaction journal Ctrl + Y
Delete cheque, invoice, transaction, 
or item from list

Ctrl + D 

Moving around a window Key
Tab
Shift + Tab

Report column to the right Right arrow
Report column to the left Left arrow

Home
End

Line below in detail area or on 
report

Down arrow 
( )

Line above in detail area or on 
report

Up arrow ( )

Down one screen Page Down
Up one screen Page Up
First item on list or previous month 
in register

Ctrl + Page 
Up

Last item on list or next month in 
register   

Ctrl + Page 
Down
Ctrl +
Ctrl + 

Close active window Esc or Ctrl 
+ F4






